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Introducing Knoppix

Introducing Knoppix

“Knoppix is… so astoundingly useful it's nearly impossible to overpraise” -- slashdot.org
(http://www.slashdot.org/)

What is Knoppix?

Linux that runs from CD

Knoppix is an astonishingly clever product. It is a single CD that runs Linux on your PC or
laptop. It gives you a full graphical desktop with networking, sound, the lot (subject to
suitable hardware). No installation is necessary.

Knoppix is excellent for demonstrations, system recovery, or just testing how well the
hardware in a given PC is supported. The Knoppix CD is compressed. On-the-fly
transparent decompression gives a remarkable 1,600 Mb of software on a single 700 Mb
CD.

Can be installed on a Hard Disk or a USB key

You can optionally install Knoppix on your hard drive from the Knoppix LiveCD. Type
knoppix-installer in a root console when using Knoppix.
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For installation on a USB key see http://www.knoppix.net/wiki/USB_Based_FAQ

How it works

Start the computer using the Knoppix CD. The existing software on the hard disk will be
bypassed. The hard disk may still be accessed read-only. When you have finished using
Knoppix, restart and take the CD out. The regular operating system will run as normal.

Safe to run

Knoppix leaves your existing software untouched. In fact, Knoppix can run on a computer
with no hard disk at all! After running Knoppix, simply take the CD out of the drive. The
computer will behave as if nothing has happened.

The general philosophy of Knoppix is to access disks in read-only mode as much as
possible. This is ideal for beginners, because it protects against accidents.

Personal

Settings and personal files can be saved to a disk, such as a removable USB hard drive
stick. This lets you store a personalised Knoppix setup and take it with you everywhere.

Free

Most amazing of all, Knoppix is free. The latest version is always available from the
Knoppix download page. Not only is Knoppix free as in no charge, it is also free as in
freedom. Subject to certain conditions, you are entitled:

To make unlimited copies.
To use one copy on as many computers as you like.
To give unlimited copies to your friends.
To sell unlimited copies.
To customise it to suit yourself.
To redistribute your customised versions.

Web link
The Knoppix download page:
http://knopper.net (http://knopper.net/knoppix-mirrors/index-en.html)

What you can do with Knoppix

Learn Linux

This book is designed to help you run Linux for the very first time. Knoppix is perfect for
newcomers. Linux isn't going away any time soon. That is why learning it is an investment
in your time that will pay off for years to come. This book is meant for people who are at
least reasonably familiar with computers. For example, I assume you know your way
around your computer's mouse, keyboard, CD drive, and so on.

Rescue and test

Knoppix is a wonderful tool for rescuing and testing PCs. I will provide enough information
to be useful, without going into mind-bending detail. With Knoppix it is possible to:

Read files from Windows formatted hard disks, even when the operating system
installed on the hard disk cannot be started (unless the hard disk has an
unrecoverable data error, or if it is physically damaged).
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Copy files onto other disks, such as removable USB drives, Zip drives, CD-RW blanks
and network drives (given suitable hardware).
Identify hardware, even when Windows cannot identify it (subject to certain
limitations).

Use and explore

Knoppix is a complete desktop system. Use it:

To print.
To play music.
To use a scanner or a digital camera.
To connect to the Internet.
To browse the Internet's World Wide Web.
To send and receive Internet email.
To try out the built-in office applications, graphics tools, sound playing, video playing,
Internet applications and games.

Network

Knoppix is a child of the Internet. Knoppix does networking with its eyes closed. For
security reasons, Knoppix does not automatically run any servers that could be accessed
from the outside.

Where Knoppix comes from

Knoppix was created in Germany by Klaus Knopper. Knoppix is a volunteer, co-operative,
community effort. It exists entirely on the Internet. At the moment Knopper is the man who
does most of the work on the disk. He does get patches and some scripts from the
community, but he is still the most important person. The Knoppix project is hosted by
LinuxTag, which is based in Germany at the Technical University of Kaiserslautern. The
LinuxTag team runs conferences, workshops and exhibitions for everyone interested in
Linux and Free Software.

Web links
The home page of Klaus Knopper(in German):
http://www.knopper.net/
The home page of LinuxTag (in German):
http://www.linuxtag.org/

Knoppix is Free Software

Knoppix is Free Software. It is licensed under the GNU General Public Licence (GPL). Free
Software is not freeware, and not shareware. Free Software means “free as in freedom”,
not necessarily price. This means you are allowed to run, copy, distribute, study, change
and improve Knoppix at no charge.

The catch is that when you give (or sell) copies to other people, you must give them the
same freedoms under which you received it. This limitation ensures that Knoppix is free
now and will remain free forever. For more details, see the license text at the end of this
book.

Web link
The Free Software Definition: 
http://www.gnu.org/philosophy/free-sw.html

Limitations
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No warranty

First and most important of all, Knoppix is experimental software. There is no warranty.
Use it at your own risk.

CD means slow

Compact Disc Read Only Memory (CD-ROM) drives are much slower than hard disk drives.
This means that some applications on the Knoppix CD may take a long time to start; much
longer than they would do on a full permanent Linux system. However, Knoppix has some
clever (optional) tricks that can spectacularly speed things up.

Knoppix does not get very far on unreliable CD-ROM drives. Since everything has to be
loaded from CD, it falls over pretty quickly if CD-ROM errors occur, or if the Knoppix CD
itself is damaged. Knoppix has built-in tools for testing its own media.

Not everything works

Knoppix supports a huge range of common PC hardware, but not everything. Internal
dial-up modems and external USB broadband modems tend not to work. AOL and
Compuserve are completely incompatible. Certain cheap printers may be useless. Many
cheap colour laser printers do not work. Support for wireless (802.11b) network adapters
is limited at best. Certain types of multimedia audio and video files are unplayable. Most
commercial DVD movie discs cannot be played. In general, Knoppix does not run Windows
software.

RAM intensive

Knoppix works by loading everything into Random Access Memory (RAM). The more RAM
you have, the better. For typical performance, you need 128 Mb of RAM.

If you are lucky enough to have 828 Mb of RAM or more, Knoppix has clever tricks to make
good use of all the RAM in your computer. This can deliver blazingly fast performance.

If you have less than 128 Mb of RAM, Knoppix has the ability to use part of the hard disk
as if it were RAM. This is called creating a swap file. However, this technique does not
work on all hard disks, and performance is much slower than real RAM.

Web link
LiveDistro Knoppix Resource (http://www.livedistro.org/search/node/knoppix)

What is included in Knoppix?

Knoppix is a compilation of a huge number of works from around the Internet. Some of the
projects mentioned in this book are:

Project Home page

AbiWord word processor http://www.abisource.com/

Audacity sound recorder http://audacity.sourceforge.net/

Common Unix Printing System (CUPS) http://www.cups.org/

Debian distribution http://www.debian.org/

Gnumeric spreadsheet http://www.gnumeric.org/

The GNU Image Manipulation Program (The Gimp) http://www.gimp.org/

GNU utilities http://www.gnu.org/
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The K Desktop Environment (KDE) http://www.kde.org/

Linux kernel http://www.kernel.org/

Mozilla web browser http://www.mozilla.org/

OpenOffice.org office suite http://www.openoffice.org/

Samba file sharing server for Windows PCs http://www.samba.org/

Scanner Access Is Now Easy (SANE) http://www.sane-project.org/

Xine Media Player http://xinehq.de/

X Multimedia System http://www.xmms.org/

X Window System http://www.xfree86.org/

Putting it all together is the work of the Debian project. The result is called the Debian
distribution. This means that Knoppix is Debian modified to run on a self-contained CD.

What is Linux?

Linux (pronounced "lin-ucks") is a free operating system. An "operating system" is the base
software that makes a computer useful.

Strictly speaking, Linux is the kernel. The kernel is the core component of the operating
system. Think of an operating system as a nut. The shell is the part that you use. The
kernel is the core that talks to the computer's hardware.

Note
There are many different Linux distributions.
But there is only one current version of the Linux kernel.
Therefore, every distribution contains Linux.

A little history

In the 1970s, computer programs were free. A program is a sequence of instructions that
makes a “calculating machine” do something useful. The engineers who worked on these
instructions became known as programmers. They shared their know-how with each other.
They found that it made their work more pleasant.

Unfortunately, this co-operative spirit died under commercial pressures. Restrictive
practices in the fast-growing “software industry” meant that sharing the most useful
programs and some of the most vital technical information became largely impossible.

A man named Richard Stallman was greatly frustrated by this change. He wanted to bring
back the spirit of the early days that he had known at MIT (Massachusetts Institute of
Technology). He knew that he had the perfect skills to build a free operating system. He
knew that if he didn't do it, no-one would. So he decided to do it, or “die trying”.

By the 1990s, Stallman's Free Software Foundation had found or created nearly all the
components of a free operating system. He called his creation “GNU's Not UNIX”.

The name is a joke designed to poke fun at the alphabet soup of computer acronyms. Some
acronyms have other acronyms as part of their definition. The GNU acronym takes this one
stage further - it has its own acronym as part of its definition. “Is Not” is a way of saying
“is like” or “is compatible with”.

UNIX refers to a family of operating systems that were used mainly in science, engineering
and finance. Stallman chose to base his efforts on UNIX because it was tried and tested. It
would also be convenient for other people to switch from UNIX to GNU.
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Linux creator Linus
Torvalds.

How GNU grew

In 1991, the GNU project still lacked a kernel, the vital core
component of an operating system. Luckily, a student in
Finland called Linus Torvalds created one “as a hobby”.

In 1991, Torvalds produced a simple, basic system called
“Freax”. He called it “Linux” privately but never meant it to
be called that in public, because he didn't want to be too
egotistical. He made it free because he wanted feedback. It
was posted on the Internet by a friend.

Pretty soon, Torvalds began receiving email from places
he'd dreamed of visiting, like Australia and the United
States. Instead of cash, Linus preferred postcards. His
sister Sara was suddenly impressed that her brother was
somehow hearing from new friends far away.

Torvalds had used the Free Software Foundation's tools, so
he decided to make it free likewise. This was a way to say
“thank you”. He decided to put Linux under the Free
Software Foundation's General Public Licence. This meant
that anyone could use, improve or sell Linux, but no-one
could take overall control.

It's a GNU world!

From there, it snowballed in the most extraordinary way. It has catapulted Torvalds to
accidental super-stardom. He has appeared on the cover of Time magazine. We should
remember that Stallman started it all. That is why the full title of Linux is GNU/Linux. In
other words, Knoppix is a Linux-based GNU system.

Web link
Overview and history of the GNU project: 
http://www.gnu.org/gnu/gnu-history.html

Knoppix for the first time

Knoppix for the first time

“The most important design issue… is that Linux is supposed to be fun.” -- Linus Torvalds

Overview

The purpose of this section is to get you started into Knoppix for the very first time. This
section skips nearly all of the options for starting Knoppix. The options for starting Knoppix
are explained later.

Hardware requirements

The recommended hardware is as follows:
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Pentium I 350 MHz processor (recommended minimum).
128 Mb RAM.
Either: IDE or SCSI bootable CD-ROM or DVD drive
Or: 3.5" floppy drive plus non-bootable CD-ROM or DVD drive.
SVGA compatible graphics card (most cards supported).
Monitor capable of 800x600 pixel resolution.
Serial mouse, or PS/2 mouse, or USB mouse.

Starting Knoppix

There are two stages to starting Knoppix:

The first stage

The first stage is to get to the boot prompt. The boot prompt lets you customise the
Knoppix startup process. For example, you can specify at the boot prompt what screen
resolution you want Knoppix to use. To reach the boot prompt, you use either the CD/DVD
or the floppy disk. What about some instructions for use with USB???

The second stage

The second stage is to run Knoppix itself. This requires the CD/DVD. Knoppix follows the
instructions given at the boot prompt to complete the startup process.

The first stage

Getting to the boot prompt

To get to the boot prompt, follow these steps:

If the computer is already on, insert the Knoppix CD/DVD. If the CD/DVD drive is set
to auto-run, information explaining about Knoppix will appear. Restart the computer.

1. 

If the computer is off, turn it on, then immediately insert the Knoppix CD/DVD. To play
for time, press the Pause/Break key immediately after turning your computer on. On
many PCs and laptops, this will pause the BIOS, giving you more time to insert the
CD/DVD. Then press the Pause/Break key again to resume startup.

2. 

Most newer computers will automatically check for a bootable CD/DVD in the first
drive. The Knoppix boot prompt should then appear. The boot prompt is the last three
lines at the bottom of the screen. If your computer can't display the white and blue
Knoppix logo, you will get a blue background instead.

3. 

On some computers, you must press a key for the “boot device menu”. The boot
device menu is used to tell the computer which drive to boot from. A prompt saying
which key will display the boot menu will appear on the screen just after you turn the
computer on. For example, on some Dell desktop PCs, press F12 when prompted,
press the Down Arrow key until “Boot from IDE-CDROM” is highlighted, then press
Enter.

4. 

At the boot prompt, press Enter to boot Knoppix accepting all the defaults (including
the German keyboard/language.) If you do nothing for 60 seconds, Knoppix boots
automatically. To boot Knoppix with another keyboard/language, see the section
“Which language?” below.

5. 

Tip
If you have two CD/DVD drives, and one of them is a CD/DVD Re-Writable drive, 
put the Knoppix CD/DVD in the other drive.
Keep your writable drive empty if you can.
This will let you try out the CD/DVD writing features in Knoppix easily at a later time.

Help at the boot prompt
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Press F2 for the help screen. The help screen is a summary of the boot prompt options.
Pressing F2 or any other key cancels the timer, so Knoppix will not automatically boot.

Quick help

Question: How do I get out of the boot prompt?
Take the disc out of the drive, then restart your computer.

Question: How do I use the boot floppy?
Turn off the computer. Insert the Knoppix boot floppy disk. Turn the computer back on. The
computer should boot from the floppy drive. Then the Knoppix boot prompt should appear.

If that doesn't work, enter your computer's Basic In/Out System (BIOS) setup. The key to
press that takes you into the BIOS setup is usually shown on the screen just after you turn
the computer on. Visit the boot priority screen (it may have another name such as boot
device menu). Set the BIOS to boot from the CD/DVD or floppy drive before the hard disk
drive. If unsure, check with your motherboard or computer manufacturer.

Question: The computer has two CD-ROM drives. Why does the Knoppix disc boot
in one drive but not the other?
Some BIOSes can only boot the first CD-ROM/DVD drive. To work around the problem,
start up from the Knoppix boot floppy disk. Then you can put the Knoppix CD/DVD in either
CD-ROM/DVD drive. If you are really determined, switch the CD-ROM/DVD drive order so
the drive you want to boot from is the first drive.

The second stage

Starting Knoppix proper

To start Knoppix with the United Kingdom keyboard/language:

Type this at the boot prompt:
knoppix lang=uk

1. 

Press the Enter key on the keyboard.2. 
Knoppix will begin loading with the UK keyboard/language.3. 

Which keyboard/language?

The most important option at the boot prompt is the keyboard/language. More correctly,
the keyboard/language option sets the locale. A locale is a collection of regional settings
including keyboard layout, language, time format, date format, currency format and paper
size. Some language translations may be incomplete.

The locale options are named using the International Standards Organisation two-letter
country codes (ISO 3166 and ISO 639). The locale options are:

Code Keyboard/language

de German (default)

be Belgian

bg Bulgarian

ch Swiss

cn Simplified Chinese

cs or cz Czech

dk or da Dansk

es Spanish
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fi Finnish (incomplete)

fr French

he or il Hebrew

it Italian

jp Japanese (limited)

nl Dutch

pl Polish

ru Russian

sl Slovenian

tr Turkish

tw Traditional Chinese

uk United Kingdom

us United States

Automatic hardware detection

Knoppix will then try to detect the various items of hardware in your computer. How long it
takes depends upon the speed of your machine. Here are some examples to give you an
idea of what to expect:

Processor RAM CD-ROM speed Time needed

Intel Pentium 4 (2.6 GHz) 512 Mb 48x 40 seconds

AMD Duron (1 GHz) 256 Mb 32x 45 seconds

AMD Athlon (600 MHz) 128 Mb 24x 1 min 30 seconds

The X Window System

Next, it will briefly say “INIT: Entering runlevel 5” and then Knoppix will try to start the X
Window System. The X Window System is the graphics display.

If you have a supported graphics card, you will see a black cross on a grey stippled
background. This means the X Window System started successfully.

The K Desktop Environment

Knoppix will begin loading the K Desktop Environment. KDE runs on top of the X Window
System. The progress of loading KDE will be shown in the middle of the screen. When KDE
has finished loading, the welcome page will be loaded.

When the welcome page appears, congratulations! You have started Linux, the X Window
System, and the K Desktop Environment successfully.

Quick help

Question: Why does KDE come up in German?
You need to specify the keyboard/language at the boot prompt. For example, for the UK
locale, enter knoppix lang=uk at the boot prompt.

Question: It says 'cloop: read error', what does that mean?
There is a problem reading the Knoppix CD. You either have a faulty CD-ROM drive or a
damaged CD. To test the Knoppix CD, enter at the boot prompt:
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knoppix testcd

This will make Knoppix check the media for errors. If you know that the Knoppix CD is
good, this error usually means a faulty CD-ROM drive.

Question: I get a blank screen when the X Window System comes up, why?
Knoppix is trying to use a screen resolution that your monitor doesn't support. For
example, Knoppix may have detected your graphics card is capable of 1024x768 pixel
resolution, but your monitor can't cope with that. Try setting a lower resolution at the boot
prompt. For example, enter:

knoppix lang=uk screen=800x600

This will make Knoppix use a screen resolution of 800 by 600 pixels when it starts the X
Window System.

Question: Why does the screen go blank when the kernel boots?
This problem usually occurs with low cost TFT (flat screen) monitors. The kernel is using a
framebuffer console, but the monitor is incompatible with it. Turn off the framebuffer
console. At the boot prompt, use the option “vga=normal”. For example, type:

knoppix lang=uk vga=normal

This will turn off the framebuffer console and the penguin logo.

Question: Why doesn't the mouse work?
This could mean you are trying to use a PS/2 mouse in a 9-pin serial port through a
PS/2-to-serial adapter. Some PS/2 mice do not work when plugged into a 9-pin serial port.
Try a real serial mouse.

Question: It says “Initrd extends beyond end of memory”.
Your motherboard is reporting the RAM size incorrectly. Specify the amount of physical
RAM in your computer at the boot prompt. For example, if you have 128 Mb of RAM, enter
at the boot prompt:

knoppix lang=uk mem=128M

Question: It says “Could not find the KNOPPIX filesystem, sorry. Dropping you to a
(very limited) shell.”
Try booting with:

knoppix ide2=0x180 nopcmcia

If that doesn't work, it means your PCMCIA CD-ROM drive is not supported. There is a
workaround. In Windows, copy the directory called “KNOPPIX” from the Knoppix CD to the
root of a local FAT formatted hard drive partition (eg: drive “C:”). The copy will take some
time to complete. Then start Knoppix and specify the partition that you copied the
KNOPPIX directory to, using the “fromhd=” boot parameter. For example, boot with:

knoppix fromhd=/dev/hda1

If Windows is not available, use a single-floppy Linux such as “tomsrtbt” to do the copy,
however that is beyond the scope of this book.
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KDE 3.4 running in Slax, another Live Linux
distro

Getting out

Now that you've got Knoppix up and running, feel free to have a poke around. Everything
is read-only, so you're unlikely to do any harm to your computer. To exit Knoppix:

Click the “K” menu in the bottom left corner.1. 
Click “Logout”.2. 
Knoppix will begin shutting down.3. 
The Knoppix CD will be ejected.4. 
Remove the CD and close the tray.5. 
Press Enter on the keyboard.6. 
Knoppix will attempt to turn off the computer automatically. If it doesn't turn off
automatically, it is now safe to turn off the computer yourself using the power button.

7. 

Tip
For a quick exit, press Ctrl+Alt+Backspace. This “three finger salute” kills the X Window System.
Killing the X Window System takes down KDE and all its open applications.
Knoppix will then shut down automatically.

The K Desktop Environment

The K Desktop
Environment

The K Desktop Environment is a modern,
powerful and free graphical user
interface environment for UNIX
compatible systems. Its name is a play on
the Common Desktop Environment
created by Sun Microsystems in the
1980s. This section explains what KDE
has to offer.

Web link
The home page of the K Desktop Environment:
http://www.kde.org/

Single click, not double-click

KDE looks familiar to Windows and Macintosh users because it takes some of the best
elements from each. There is an important difference: everything is single click. Nothing
needs a double-click to make it work. If you double-click, you'll end up with a program
running twice, or something else you don't need. Just single click. To revert this to what
you may be used to, there is an appropriate setting under Peripherals -> Mouse in the
Control Center.

Tip
To select a file instead of opening it, hold down the Ctrl key and click the left mouse button.
The icon will be selected, rather than opened.
It is then safe to let go of the Ctrl key.

Context menus everywhere
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Konqi: the KDE mascot

Most icons have a context menu. To get the context menu
for an icon, right-click on the icon. You'll get a little pop-up
menu of common actions for that icon. This also works on
window edges, toolbars, and just about everything else.

Tip
Right-click to see the context menu for an item.

Hover the mouse for help

Like Macintosh and Windows, most icons have a tooltip.
Hover the mouse pointer over an icon. A little yellow label
will tell you what that icon does. Tooltips only work in the
current active window. This means that if you have two
windows open, you will only get tooltips in the window that
is at the front. To get tooltips in the other window, you must
click it to bring it to the front.

Tip
Not sure what an icon does? Hover the mouse pointer over it.

The Desktop

The main part of the screen is called the Desktop. This is where the application windows
appear. There are also icons for each disk device in the system.

Here are device icons for two CD-ROM drives, a 1.44 Mb floppy drive, and a hard disk
partition. Notice that the “hard disk partition” icon has the name “hda1”. Knoppix has its
own way of naming disks and partitions. For details, see the section “Knoppix essentials”.
These icons are actually hyperlinks. In other words, they are just pointers to the place in
the system where the files appear. You can't drag and drop files and folders onto Desktop
device icons, as you can on the Apple Macintosh.

Note
Desktop icons are shortcuts. There are no files inside Desktop icons.
Instead, Desktop icons are just pointers to the places where the files actually appear.

If you plug in a hot-pluggable disk device, such as a USB external hard drive, a new icon
for it will appear on the Desktop. This behaviour will be familiar to Apple Macintosh users.

The Panel

At the bottom of the screen is the Panel. The Panel is always visible. It contains various
utilities and status information.

K Menu

In the far left corner of the Panel is the K Menu which is just like the Windows “Start”
menu. Click for a list of programs that are available on the system.

Quick launch

Next to the K Menu are Quick Launch icons. These icons represent frequently used
programs. Hover the mouse pointer over the program icon for a description of what it
does. Single-click on the icon to start that program. Be aware that the OpenOffice program
may take several minutes to start, especially if you have a slower computer.
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Desktop Guide

The Desktop Guide consists of four squares. Each square represents one desktop. You start
off in the first desktop. Click in the Desktop Guide to switch between the four available
desktops. To move open windows between Desktops, click the Window Control Box at the
top left corner of the window. Point at “To desktop”, then choose the Desktop that you
would like to send the window to.

Taskbar

A button is shown in the Taskbar for each open window. This example shows three open
windows; Konsole, the Konqueror web browser, and the GIMP graphics editor.

System Tray

The System Tray contains an icon for the current keyboard layout. To view the available
keyboard layouts, right-click on the keyboard layout icon.

Clock

The clock shows the time and date.

Hide Panel

At each end of the Panel is a Hide Panel button. Click the Hide Panel button to make the
Panel shrink to that side of the screen. Click the button again to unhide the Panel. Drag the
Hide Panel button to move the entire Panel from one side of the screen to another.

Left mouse button selects text, middle button pastes

To copy and paste text using a three button mouse:

Select the text that you want to copy and paste with the left mouse button, so that the
text is highlighted.

1. 

Point to the place where you want the text to go.2. 
Click the middle mouse button. The last selected text will be pasted from the X
Window System's copy buffer into the place where you clicked.

3. 

This also works in other window managers that run in X. If this method doesn't work, you
can use the Ctrl+C > Ctrl+V or the Ctrl+Insert > Shift+Insert combination. The latter key
combination is slightly older, but is supported in apps that don't support the former
combinations.

Alternatives to KDE

See also: Alternatives to KDE

For whatever reason, you may you might want to try something other than KDE. Several
alternatives exist, such as GNOME, Xfce, and WindowMaker. GNOME, being an entirely
separate desktop environment rather than a window manager, is distributed within
Gnoppix. For more info, see Alternatives to KDE. Once knoppix has loaded you can switch
between the various alternatives.

In newer versions of Knoppix, Beryl may be supported (this depends on your hardware).
Although using Beryl is almost identical to using KDE it must be specified at boot time
with:
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knoppix desktop=beryl

Knoppix essentials

Knoppix essentials

“If I ever met Bill Gates, there wouldn't be much of a meeting point. I couldn't tell him
about business, and he couldn't tell me about technology.” -- Linus Torvalds

This section contains important background information that will help you understand the
rest of this book. If you are in a hurry, skip over this section. The terms explained in this
section will be used often, so you may need to refer back to this page later.

File names

The following rules apply to file names in Knoppix.

Case sensitive. This causes the most problems for beginners. For example,
“myfile.txt”, “MyFile.txt” and “MYFILE.TXT” are all different names.
Long file names are allowed. File names can be up to 255 characters long.
There is no “C:” drive. Instead, all files are arranged in a tree beginning with “/”,
which is called the root directory. The “root directory” is like “My Computer”. It is the
starting point for everything stored inside in the computer.
Forward slashes. For example, in Windows, part of the location of an image file
might be:
My Documents\My Pictures\duck.jpg

In Knoppix, the backslashes that represent the path to the file are written as forward
slashes instead, like this:
My Documents/My Pictures/duck.jpg

Note
What's the difference between a directory and a folder? Not much.
A folder is just the icon that is usually used to represent a directory.
The words “directory” and “folder” are interchangeable.
Remember, a hard disk is like a filing cabinet.
Partitions are like drawers, directories are like folders, and files are like individual documents.

Drive names

You may be used to Microsoft Windows' naming scheme for disk drives. For example, you
may be used to “drive A:” for the first floppy drive; “drive C:” for the first visible hard drive
partition, and so on. Knoppix has its own drive naming scheme. This section explains how
the naming scheme works.

Disk types

The naming scheme starts with a two-letter code for the type of disk.

Name Drive type

fd Conventional floppy drive

hd Integrated Drive Electronics (IDE) drive
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sd Small Computer System Interface (SCSI) drive

IDE drives

IDE drives are the most common in desktop PCs and laptops. A single letter indicates how
the drive is connected. Most PCs and laptops have two IDE channels: primary and
secondary. Each channel can have up to two devices: master and slave.

Name IDE drive

hda Primary Master

hdb Primary Slave

hdc Secondary Master

hdd Secondary Slave

SCSI drives

For SCSI drives, a single letter indicates its location. This is called its position in the SCSI
chain. Zip, USB and Firewire drives are also treated as SCSI drives.

Name SCSI drive location

sda First SCSI drive

sdb Second SCSI drive

sdc Third SCSI drive

Disk partitions

IDE and SCSI hard drives are divided into partitions. Zip, USB and Firewire drives also
contain partitions. A partition is like a compartment within a disk. There may be a single
partition that covers the entire disk. There may be more than one partition. Each partition
is indicated by a number.

Name Drive Partition

hda1 Primary master IDE drive First partition

hda2 Primary master IDE drive Second partition

hda3 Primary master IDE drive Third partition

SCSI emulation for IDE CD-ROM drives

IDE CD-ROM drives are treated as SCSI drives. This is called SCSI emulation. SCSI
emulation is there so that CD burning applications can use the same language to talk to
SCSI and IDE drives.

Name CD-ROM drive

scd0 First CD-ROM drive

scd1 Second CD-ROM drive

scd2 Third CD-ROM drive

Conventional 1.44 Mb floppy drives

For ordinary floppy disk drives, a number shows the drive number.
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Name Floppy drive number

fd0 First floppy drive

fd1 Second floppy drive

Drive detection

Knoppix automatically detects all IDE and SCSI devices. The names of the devices are
printed in the startup messages (Ctrl+Alt+F1). Here is an example:

hda: [FUJITSU MPA3026AT]
hdb: [LS-120 VER5 00 UHD FLOPPY]
hdc: [HITACHI DVD-ROM GD-2500]
hdd: [MATSHITA CD-RW CD-7586]

This example shows that the primary master is a Fujitsu hard drive. The primary slave is
an Imation LS-120 SuperDisk drive. The secondary master is a Hitachi DVD-ROM drive.
The secondary slave is a Matshita CD-RW drive.

Partition detection

Knoppix automatically detects all partitions on all IDE and SCSI devices. For example,
given a single Windows partition on the primary master IDE hard drive, the following
device name will be created:

/dev/hda1

This means the partition will be called /dev/hda1 in Knoppix.

Note
Some removable disks also have partitions, notably Iomega Zip disks.
For the partitions on an Iomega Zip disk to be detected properly, you must insert the disk into the drive before you start Knoppix.

Mount points

Each device name has a mount point. This is a special place where the files on a device
appear. A mount point is created automatically for each device name. For example, given
the Fujitsu drive above, the following mount point will be created:

/mnt/hda1

This means the partition /dev/hda1 will be mounted to /mnt/hda1.

Auto-mounting of floppy and CD-ROM drives

Conventional floppy and CD-ROM drives are auto-mounted. This means Knoppix takes care
of mounting and unmounting them automatically. The auto-mount locations are:

First floppy drive: /mnt/floppy
Second floppy drive: /mnt/floppy1
First CD-ROM drive: /mnt/cdrom
Second CD-ROM drive: /mnt/cdrom1

Login accounts

When you start Knoppix, you are logged in automatically. No passwords are needed. All
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passwords are locked by default. Knoppix bypasses all the usernames and passwords of the
operating system installed on the hard disk.

Keyboard shortcut Virtual terminal Logged in as user account

Ctrl+Alt+F1 Console number 1 root

Ctrl+Alt+F2 Console number 2 root

Ctrl+Alt+F3 Console number 3 root

Ctrl+Alt+F4 Console number 4 root

Ctrl+Alt+F5 X Window System (KDE) knoppix

You can switch between the virtual terminals at any time. For example, to switch to the
first console, press Ctrl+Alt+F1. The Knoppix startup messages will be displayed. To
switch to the second console, press Ctrl+Alt+F2. To get back to the X Window System,
press Ctrl+Alt+F5.

Note
The X Window System is on virtual terminal number 5.

User accounts

The user account

The Knoppix user account is called “knoppix”. This account is for all productivity tasks,
including CD burning and printing. When the X Window System starts, you are logged in to
that user account automatically, without a password.

The superuser account

The superuser account is for system administration tasks. The superuser account is called
the root account. When Knoppix starts, you are logged in as root to all four consoles
automatically with no password. It is also possible to use the root account within the X
Window System.

Important
As with other Linux distributions, use the user account for all your everyday tasks.
Only use the root account when you need it.
For example, when you are logged on as root, you have the power to instantly delete every file on every disk with one simple command.
When you are logged on as a user, the system will not let you do that. This helps you to protect yourself against accidents.
Get into the habit now and it will save you later!

Identifying hardware

Common hardware
Knoppix has built-in hardware identification. This means Knoppix can identify the make
and model of a huge range of common PC components, such as processors, graphics cards,
network cards, and so on. To use the hardware identification:

Click K Menu.1. 
Click System.2. 
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Click Info Center.3. 
The Info Center application will come up. On the left side are the various categories.
Click a category to view the details.

4. 

The most useful categories are:

Processor (Central Processing Unit).
Memory (Random Access Memory, or RAM).
Partitions (partitions on hard disks and other drives).
PCI (Peripheral Component Interconnect cards).
PCMCIA (credit-card sized cards for laptops. PCMCIA stands for Personal Computer
Manufacturer Interface Adapter).
Storage Devices (hard disks and other drives).
USB Devices (Universal Serial Bus peripherals).

Note 
If you plug in a new USB device, and you are already on the USB Devices page,
choose any other category and then select USB Devices again to refresh the list.

Listing hard disks
To get a listing of the hard disk drives in the computer, including the make and model of
each one:

Click the Konsole (bottom row, 6th from the left).1. 
Enter the following command, then press Enter.
dmesg

2. 

The dmesg command shows the “kernel messages”. You will get quite a lot of output.
Scroll up about two-thirds of the way until you see lines like this:
hda: ST320410A, ATA DISK drive

hdc: JLMS XJ-HD165H, ATAPI CD/DVD-ROM drive

hdd: LITE-ON LTR-52327S, ATAPI CD/RW drive

The example above is from a computer with IDE drives. It has one hard disk drive and
two CD drives. The primary master (hda) is a “Seagate Technology 320410A” hard
disk drive. “ATA” stands for “AT Attachment”. The secondary master (hdc) is a DVD
drive and the secondary slave (hdd) is a CD writer.

3. 

Tip
To see only the lines from dmesg that contain the letters “hd”, enter:
dmesg | grep hd

The “|” character is a vertical bar, not a capital “i”.
On a UK keyboard layout, the vertical bar is on the key between “Z” and the left
“Shift”.

Limitations
The ability to identify hardware is tremendously useful. However, there are limitations you
should know about.

Hardware newer than Knoppix

The most important limitation is that Knoppix cannot accurately identify PCI and PCMCIA
hardware that is newer than Knoppix is. USB and Firewire devices work differently and are
not subject to this limitation.

This book comes with Knoppix version 3.3, which is dated September 2003. Knoppix
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should be able to identify most hardware made before that date (except the very old or
very rare).

However, Knoppix version 3.3 may only be able to identify PCI and PCMCIA hardware
made after September 2003 as an “Unknown device”. A newer version of Knoppix may
help. A newer version can be obtained from the Knoppix web site and from other vendors.

Winmodems

The vast majority of modems made these days are winmodems. A winmodem is a modem
that relies on the CPU for some of it's communication routines. This is done to save a few
components and reduce manufacturing costs. Winmodems tend not to work well with
Linux. A common example is the Intel 537 series of PCI internal modem cards.

Knoppix can only tell you what a winmodem identifies itself as, in its hardware. Knoppix
cannot tell you about the Windows-specific software needed to get it working in Windows.
For example, in the case of Intel 537 based winmodems, there are many different vendor-
specific Windows drivers, which may be incompatible with each other. However, these
cards will all be reported the same in Knoppix. That is more a limitation of the hardware,
rather than a limitation of Knoppix.

Identified does not mean supported

Knoppix may not have driver support for all the hardware it can identify. In other words,
just because Knoppix tells you the make and model of a device does not mean it actually
works in Knoppix. For example, the Intel 536EP internal modem PCI card is accurately
identified; but it is not usable because it requires proprietary software that cannot be
distributed with Knoppix.

Not guaranteed

The identification provided by Knoppix may be wrong. This is because Knoppix is not
perfect (sorry). However, it is pretty reliable. For example, in two years of using Knoppix
every day, I have had only one instance of wrongly identified hardware (a fairly obscure
sound card).

The hardware identification strings are mostly provided by Linux users, rather than the
hardware vendors themselves. However, the hardware vendors are not perfect either.
Sometimes the Linux users' identification corrects mistakes made by hardware vendors!

Reading the hard disk
Knoppix supports all IDE and most SCSI hard disk drives. It reads files from the full range
of Microsoft operating systems – from MS-DOS through to Windows XP.

This is useful because if you cannot start Windows, often all the data files are still there
happily on the hard disk. On many occasions, it is a simple matter to locate the files using
Knoppix. It is usually then equally trivial to rescue the files by copying them somewhere
safe (explained in the later sections).

To browse the files on the internal hard disk, look on the Desktop. You should see an icon
for each hard disk partition. To access the files on that partition:
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Click the icon for the hard disk partition.1. 
Wait for a moment while the partition is mounted. A green triangle will appear,
indicating that the partition is in use.

2. 

Wait while the Konqueror file manager starts up.3. 
The files on the partition should be displayed, read only. This example shows a typical
“drive C:” from a computer that usually runs Windows 98.

4. 

Selecting files and folders
To create data CDs and copy files and folders onto other disks, you need to know how to
select. There are several ways to select files and folders:

Lasso. Click and hold the left mouse button on a blank area in the Konqueror window.
Drag across to the opposite corner. The files and folders in the marked area will be
selected. To deselect, click any blank area within the window.
Ctrl + click. Hold down the Ctrl key on the keyboard, and click a file or folder. It will
be selected. To deselect, Ctrl + click the file or folder icon again, or click any blank
area within the window.
Shift + click. Ctrl + click the first file or folder. Let go of the Ctrl Key. Hold down the
Shift key, and select the last file or folder. The range will be selected. To deselect,
click any blank area within the window.
Right-click. Click the right hand mouse button on a file or folder. A “context menu”
will appear, showing the most common actions for that item. The file or folder will also
be selected. To deselect, click any blank area within the window.

Enabling write access
Knoppix has the optional ability to write to hard disk drives. Write mode lets you copy files
to the drive, and change existing files. Knoppix supports writing to MS-DOS and Windows
95/98/Me formatted partitions. Writing to native Windows NT/2000/XP partitions is not
supported. To enable write access:

Click the icon of the hard disk partition you want to write to.1. 
Wait for a moment while the partition is mounted.2. 
Wait while the Konqueror file manager starts up.3. 
The files on the partition will be displayed.4. 
Right-click the icon of the hard disk partition.5. 
Click “Change read/write mode”.6. 
You will be prompted to make the partition writeable. Click “Yes”.7. 
You should now be able to write files to the partition.8. 

Quick help
Question: There are no icons for the hard disk on the Desktop.
If you have an IDE hard disk, this usually means the BIOS did not detect the hard disk
drive. Go into your motherboard's BIOS and make sure the hard disk is detected by the
BIOS properly. If you have one of the recent “Serial ATA” hard drives, they are not
supported in this version of Knoppix. Try a newer version of Knoppix.

Question: I still can't access the hard disk.
The partition may be encrypted, which means it may have been specially set up on purpose
to make it inaccessible to outside tools like Knoppix. The partition table may be incorrect,
or there may be data errors. In the worst case, the drive may be physically damaged; listen
for ping-pong ball bouncing or loud rattling noises.
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Question: How can I check or test my hard disk?
Knoppix has many built-in tools, but they are beyond the scope of this book. You will need a
more advanced book, a knowledgeable friend or help online to use these tools. Having said
that, here is a hint. To list the commands that have the words “dos”, “ntfs” or “partition”
anywhere in their short description, enter:

man -k dos ntfs partition

CD reading and writing

Reading CD-ROMs
see: CD reading and writing

Knoppix has built-in support for reading Compact Disc Digital Data discs. It is best to have
two CD drives – one for the Knoppix CD, and one for the data CD that you want to read. If
not, see “If you have only one CD drive” in the “Advanced startup options” section. To read
a data CD:

Insert the data CD into an empty CD-ROM drive.1. 
Click the icon on the Desktop on that represents the drive. The “CDROM” icon
represents the first CD drive, and “CDROM1” represents the second drive. In
Windows, the first drive is given a lower drive letter (eg “D:”). The second drive is
given a higher drive letter (eg “E:”).

2. 

A green triangle will appear on the CD drive icon to indicate that the drive is in use.3. 
Wait while the Konqueror file manager starts up.4. 
The files on the CD will be displayed.5. 

Ejecting the CD

Close all windows and files opened from the CD.1. 
Press the Eject button on the front of the drive.2. 
The CD tray will be ejected.3. 

Quick help

Question: When trying to access a CD for the first time, it says “The file or
directory file:/mnt/cdrom does not exist”. What does this mean?
Usually this means the drive is still preparing itself, or the Knoppix auto-mounter has not
finished working yet. Wait a few moments, then try again. If it still doesn't work, click the
Home icon in the Panel, then type file:/mnt/auto/cdrom or file:/mnt/auto/cdrom1. If it still
doesn't work, click the Knoppix icon in the Panel, click Root Shell, then enter this
command:

/etc/init.d/autofs restart

Question: Why is the CD stuck in the drive?
Knoppix uses the locking mechanism of the drive to prevent you from taking out a CD that
is still in use. Close all windows and documents opened from the CD, then try again.
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Question: When I right-click on the CD drive's icon and then click “Eject”, it says
“Eject failed!” What does that mean?
It means the drive doesn't like the Knoppix “eject” program. Just press the eject button on
the front of the drive instead.

CD writing
see: CD reading and writing Knoppix has built-in support for CD writing. To create your
own CDs using Knoppix, it is best to have two CD drives. You need one drive for the
Knoppix CD, and a Compact Disc Re-Writeable drive for the blank media. Normally, the
Knoppix CD occupies the first drive, and it cannot be removed while Knoppix is running.

However, if you have a suitable hard disk, it is possible to start Knoppix from a single
CD-ROM drive and then use it for other CDs. See the later section, “Advanced startup
options”.

The following CD-RW drives are compatible with Knoppix:

All SCSI CD-RW drives.
Nearly all IDE CD-RW drives produced after 1999.
Some IDE CD-RW drives produced before 1999.
Most external (USB) CD-RW drives.

Knoppix uses SCSI commands to create CDs. When working with IDE CD-RW drives,
Knoppix uses SCSI emulation. This means that Knoppix works with IDE CD-RW drives
while actually using the SCSI language to talk to the drive. For this reason, SCSI CD-RW
drives are ideal, while most IDE CD-RW drives should work. To copy files onto a data CD:

Select the files or folders to be written onto CD.1. 
Right-click on the selection.2. 
Click “Create CD with K3b”.3. 
Wait for a moment while the K3b program starts.4. 
The K3b window will be displayed. In the “Current Projects” pane, you will see the
folder that you chose. To add additional files and folders, drag and drop them into the
Project pane.

5. 

The disk usage is in shown in the green bar at the bottom of the Projects pane. It
shows the amount of space that will be used on the writeable CD. This example shows
90.3 MB will be used, out of a possible 650 MB.

6. 

Click the “Burn” button (fourth from the left in the toolbar). The disk writing window
will be appear. The make and model of your CD-RW drive will be shown.

7. 

Select the writing speed to be used from the “Speed” box. The correct writing speed
to choose depends upon the speed of your CD-RW drive and the media. For example,
if you have an 8x CD-RW drive and 4-10x compatible media, choose 8x.

8. 

Click the “Filesystem” tab.9. 
Click “Generate Joliet extensions” to put a tick in the box. This step is needed to make
the CD fully readable in Windows. If you are only going to use the CD in another Linux
or UNIX computer, you do not need this.

10. 

Click “Write”.11. 
The CD will be created. When the writing process has finished, the CD will be ejected.12. 
Click “Close” to return to K3b.13. 

Quick help

Question: Why does it eject the CD and do nothing? Or, why do I get an error while
CD writing?
You may be trying to use incompatible media. For example, if you try to write onto CD-RW
media labelled “4-10x compatible” at 32x then the drive will just eject the blank CD.
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Question: When I put the written CD in a computer running Windows, some of the
file names come out in capitals and some spaces or dots are turned into
underscores. Why?
You need step 10, “Generate Joliet extensions”. The original specification for data CDs
allows each file name only 8 characters plus a 3 character extension. For example:
“hello.txt” fits, but “long file name of your dreams.txt” does not. “Joliet” is the Microsoft
way of putting long file names on a data CD.

Question: The setup works fine, but when it gets ready to burn, there are no
devices to be selected. How come?
You need to run K3B as root. Go to a terminal (the image of a monitor with a shell on it),
then type 'su', hit return, then type 'k3b' and hit return. This runs K3B as root and fixes
some issues.

Question: how to read the data from cd and dvd

Using an external USB drive
Knoppix supports two types of external USB hard drive:

USB hard drive stick (flash drive or pen drive).
Conventional external USB hard disk drive.

Knoppix uses its built-in USB Mass Storage driver to support these drives. Both USB 1.1
and the faster USB 2.0 drives are supported. USB 1.1 drives work at 12 Mbits per second
(about 1.5 megabytes per second). USB 2.0 drives work at up to 480 Mbits per second
(about 60 megabytes per second) when plugged into a USB 2.0 capable socket.

A USB hard drive stick is a small device like a key fob. Many digital cameras also work as
an external USB hard drive. Any digital camera will work provided it supports USB Mass
Storage. Some digital cameras have to be put in “DSC Mode” to enable USB Mass Storage.
To copy files onto an external USB hard disk drive:

Insert the USB drive into any USB socket.1. 
After a short pause, an icon for each partition on the new drive should appear. In most
cases there will be a single partition on the USB drive that covers the entire disk, so
one new icon will appear.
If the icon doesn't appear, take the USB drive out and insert it again more slowly.
There are four pins on the USB drive's connector. Two of the four pins are longer
because they must make contact first.
To see if Knoppix accepts the USB drive when you put it in, refer to the “Identifying
Hardware” section. Look at the Info Center's “USB Devices” and “Storage Devices”
categories.

2. 

When USB drive icon appears, click it with the left mouse button.3. 
Wait for a moment while it is mounted.4. 
The files on the USB drive will be displayed.5. 
Right-click the icon of the USB drive.6. 
Click “Change read-write mode”.7. 
Click “Yes”.8. 
Drag and drop the files or folders that you want to copy into the window of the USB
drive.

9. 

Click “Copy Here”.10. 
The files or folders will be copied.11. 
When copying has finished, close all open windows for the USB drive.12. 
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Right-click on the icon of the USB drive.13. 
Click “Unmount”.14. 
The green triangle on the USB drive's icon will go away.15. 
It is now safe to take the USB drive out of its socket.16. 

NOTE:
Knoppix version 3.3 does not support USB 2.0, as claimed.
USB 2.0 devices such as external hard disks do work with Knoppix version 3.3, but only at the USB 1.1 speed (ie: much slower).
If you need full USB 2.0 speed, try Knoppix version 3.6 and start with "knoppix usb2" at the boot prompt.

Quick help

Question: I still can't get my USB drive to appear.
Click Konsole, then type dmesg. If the drive is connected successfully, you will see lines like
this at or near the end of the output:

scsi2 : SCSI emulation for USB Mass Storage devices
 Vendor: USB2.0    Model: Flash Disk        Rev: 2.00
 Type:   Direct-Access    ANSI SCSI revision: 02
Attached scsi removable disk sda at scsi2
SCSI device sda: 512000 512-byte hdwr sectors (262 MB)
sda: Write Protect is off
 sda: sda1

This shows that a “USB2.0 Flash Disk” has appeared as the first SCSI drive (sda). It is 262
Mb in size. It contains one partition (sda1). If you insert a USB drive too quickly, it will say
“unable to read partition table” instead of “SCSI device”. This means try again, more
slowly.

If it still won't work, try using another USB socket.

Or you may try mounting the drive by hand:

sudo mount /dev/sda1 /media/usbdisk

Note:If the 'usbdisk' mount point doesn't exist, use an unused existing mount or create the
mount point yourself

sudo mkdir /media/usbdisk

If that doesn't help, try starting Knoppix with the USB drive already connected. If it really
won't work, buy or borrow a USB hub PCI expansion card. Put it into the computer and try
connecting the USB drive to the expansion card, rather than to the computer's built-in USB
ports.

Question: Why did it say “out of disk space” when copying to the flash drive, even
though the total size of the files to be copied is less than the free space on the
drive?
Some flash drives are formatted with the FAT12 or FAT16 filesystem. This is inefficient
when storing small files. If there are a lot of small files, the flash drive may fill up much
more quickly that you might expect. There are two ways round the problem. The first way
is to archive the files onto the flash drive. To archive means to create one big file instead of
lots of small ones. To create an archive, click K menu, Utilities, Ark (Archiving Tool). The
second way is to reformat the drive to a more efficient filesystem, such as FAT32.
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Using floppy disks

Using a floppy disk
Knoppix supports all standard 1.44 Mb floppy drives. If you have an Imation LS120
SuperDisk drive, see the later section. The SuperDisk drive is not a standard 1.44 Mb
floppy drive; it works quite differently. To copy files onto a 3.5” floppy drive:

Check the write-protect tab on the floppy disk. Make sure the tab is in the closed
(write enabled) position.

1. 

Insert the floppy disk into the drive.2. 
Click once on the “Floppy Disk” icon on the Desktop.3. 
The files on the floppy will be displayed.4. 
Drag and drop files and folders to be copied into the floppy disk window.5. 
Click “Copy Here”.6. 
The files will be copied.7. 
Wait until the floppy drive's “busy” light goes out.8. 
Close the floppy disk window.9. 
It is now safe to remove the floppy disk from the drive.10. 

Note
Unmounting a 3.5" floppy disk is done for you automatically.
There is no need to “Change read-write mode”, because the read-write tab on the
floppy disk itself controls whether it is writable or not.

Quick help

Question: How do I format a 3.5" floppy?
Right-click the “Floppy disk” icon on the Desktop, then click “Format Floppy disk”.

Question: I have an Imation SuperDisk floppy drive. Why does clicking on the
Floppy icon not do anything?
The Imation SuperDisk is not an ordinary floppy drive. It is treated as a hard disk drive.
Follow the instructions in the Imation LS-120 SuperDisk section.

Using an Iomega Zip disk
The Iomega Zip disk drive was very popular in the 1990s. It has been somewhat
superseded by the CD-RW and the USB flash drive. However, Iomega Zip drives, and their
media, are still easy to find and often useful. The usual capacity of Iomega Zip media is 100
or 250 Mb.

There are three varieties of Iomega Zip drive: internal, parallel, and USB. The internal and
parallel varieties are older and are no longer made. The USB variety is newer and is still
being made today.

Note
Iomega measures its disk capacities in megabytes where 1 megabyte = one million bytes.
This is less than the conventional definition where 1 megabyte = 1,048,576 bytes.
Knoppix uses the conventional definition.
Therefore a “Zip 100” disk has an actual capacity of 98,078 kilobytes according to Knoppix.

Using an external USB Iomega Zip drive
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The external USB Iomega Zip drive is available in 100 Mb, 250 Mb and 750 Mb versions.
The 750 Mb version also supports USB 2.0 for higher transfer speeds. Knoppix uses its
built-in USB Mass Storage driver to support the external USB Iomega Zip drive. To copy
files onto an external USB Iomega Zip drive:

With the computer turned off, plug the Zip drive into a USB socket.1. 
Insert a valid PC formatted Zip disk into the drive.2. 
Start Knoppix, but specify text mode at the command prompt. For example, enter:
knoppix lang=uk dma 2

3. 

Knoppix will start up, but then stop before loading KDE.4. 
Press Enter on the keyboard to wake up the command prompt. Type this command,
then press Enter:
rebuildfstab -u knoppix -g knoppix

5. 

You should see the activity light on the front of the drive come on, and you should
hear the drive work.

6. 

Switch to graphics mode with this command:
init 5

7. 

After KDE loads, you will see an icon for the Zip drive on the Desktop. Assuming you
have no other SCSI drives, the icon will be labelled “Hard disk partition [sda4]”.

8. 

Click the icon for the Zip drive.9. 
Wait while the device is mounted.10. 
Wait while the “Konqueror” file manager starts up.11. 
The files on the Zip disk will be displayed.12. 
Right-click the Zip drive's icon.13. 
Click “Change read/write mode”.14. 
Click “Yes”.15. 
Drag and drop the files and folders to be copied into the Zip disk's window.16. 
Click “Copy Here”.17. 
The files and folders will be copied.18. 
Close all the Zip disk's open windows.19. 
Right-click on the Zip drive's icon.20. 
Click “Unmount”.21. 
The green triangle will go away.22. 
It is now possible to take the Zip disk out of the drive.23. 

Note
Hot-plugging the external USB Iomega Zip drive is not supported.
This means you need to have the drive connected before you start Knoppix.
You can't plug the Zip drive into the computer when it is already running
and expect an icon for it to appear, as you can with USB flash drives and
other USB external hard drives.

Using an internal IDE Iomega Zip drive

The internal IDE Iomega Zip disk drive is like an internal hard drive, but with removable
writeable media. Knoppix uses its built-in ATAPI (AT Attachment Packet Interface) driver to
support the internal Iomega Zip drive. Typically the maximum disk capacity is 100 Mb. To
copy files onto an internal Iomega Zip drive:

With the computer turned off, insert a PC formatted Zip disk into the Zip drive.1. 
Start Knoppix in the usual way.2. 
You will see an icon for the Zip drive on the Desktop. Assuming there are no other
SCSI drives in your computer, the icon will be labelled “Hard disk partition [sda4]”.

3. 

Click the icon for the Iomega Zip drive.4. 
Wait for a moment while the Zip disk is mounted. A green triangle will appear
indicating that the drive is in use.

5. 

Wait while the “Konqueror” file manager starts up.6. 
The files on the disk will be displayed.7. 
Right-click on the icon of the Zip drive.8. 
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Click “Change read/write mode”.9. 
Click “Yes”.10. 
Drag and drop the files you want to copy into the Zip drive window.11. 
Click “Copy Here”.12. 
The files will be copied.13. 
Close the Zip drive's windows.14. 
Right click on the Zip drive icon.15. 
Click “Unmount”.16. 
The green triangle will go away.17. 
It is now safe to take the Zip disk out of the drive.18. 

Using a parallel port Iomega Zip drive

The external parallel port Iomega Zip disk drive is the oldest kind of Zip drive. It was
marketed for its high capacity, speed and portability. It is fully supported in Knoppix.
Everything needed to use it is included in Knoppix, however, a “helping hand” is needed.
To copy files onto an external parallel Zip drive:

With the computer turned off, connect the Zip drive to the computer's parallel
(printer) port. Connect the Zip drive to the mains and turn the Zip drive on.

1. 

Insert a valid PC formatted Zip disk into the drive.2. 
Start Knoppix, but at the boot prompt, specify text mode. For example, enter:
knoppix lang=uk 2

3. 

Knoppix will start up and then stop before loading KDE.4. 
Press Enter on the keyboard to wake up the command prompt.5. 
The next step is to enable the Iomega parallel Zip drive support. Look at the
underside of the drive. The date of manufacture should be printed there. If your drive
was made before 31 August 1998, enter this command and press Enter.
modprobe ppa

If your drive was made after 31 August 1998, type this and press Enter:
modprobe imm

6. 

If successful you will be rewarded with lines like this:
imm: Version 2.05 (for Linux 2.4.0)

imm: Found device at ID 6, Attempting to use EPP 16 bit

imm: Found device at ID 6, Attempting to use PS/2

imm: Communication established at 0x378 with ID 6 using PS/2

scsi3 : Iomega VPI2 (imm) interface

Vendor: IOMEGA Model: ZIP 250 Rev: K.47

Type: Direct-Access ANSI SCSI revision: 02

Attached scsi removable disk sda at scsi3, channel 0, id 6, lun 0

SCSI device sdb: 196608 512-byte hdwr sectors (101 MB)

sda: Write Protect is off

sda: sdb4

This means that the Linux kernel has found the Iomega external drive on the parallel
port. In this example, the drive is called “sda”, which means it is the first SCSI drive.

7. 

Type the following command and press Enter:
rebuildfstab -r -u knoppix -g knoppix

8. 

Finally type this and press Enter:
init 5

9. 

KDE will start up. You will see an icon for the Iomega Zip drive on the Desktop.
Assuming you have no other SCSI drives, it will be labelled “Hard disk partition
[sda4]”.

10. 

Click the Zip drive icon.11. 
Wait for a moment while the Zip drive is mounted.12. 
Wait while the Konqueror file manager starts up.13. 
The files on the Zip drive will be displayed.14. 
Right-click on the Zip drive's icon.15. 
Click “Change read/write mode”.16. 
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Click “Yes”.17. 
Drag and drop the files and folders you wish to copy into the Zip drive's window.18. 
Click “Copy Here”.19. 
The dropped items will be copied.20. 
When you have finished copying, close the Zip drive's windows.21. 
Right-click the Zip drive icon.22. 
Click “Unmount”.23. 
The green triangle on the Zip drive icon will go away.24. 
It is now safe to take the Zip disk out of the drive.25. 

Using an Imation LS-120 SuperDisk
The Imation LS-120 SuperDisk drive crosses laser technology with the floppy disk. “LS”
stands for “Laser Servo”. Imation SuperDisk media has a capacity of 120 Mb. The Imation
LS-120 SuperDisk was quite popular in the 1990s. For example, many computers made by
Gateway came with a SuperDisk drive fitted as standard. Today, the SuperDisk drive is no
longer made, but the 120 Mb media is still available.

The SuperDisk drive is an IDE device, like a CD-ROM drive. It does not use the
conventional floppy drive interface. However, the SuperDisk drive is backwards compatible
with 1.44 Mb floppy disk media.

Knoppix uses its built-in AT Attachment Packet Interface driver to support the SuperDisk
drive. Knoppix uses SCSI emulation to treat the SuperDisk drive as a SCSI device.
However, because of the way the drive works, it is not automatically detected so a little
“helping hand” is needed. To copy files onto an Imation LS-120 SuperDisk drive:

Insert an LS-120 disk or conventional floppy disk into the SuperDisk drive.1. 
Start Knoppix in the usual way.2. 
Right-click anywhere on the Desktop.3. 
Point to “Create New”.4. 
Click “Hard Disk”.5. 
A window for the new device will appear.6. 
On the “General” tab, replace the words “Hard Disk” with a suitable name. For
example, enter “LS-120”.

7. 

Click the “Device” tab.8. 
In the “Device” drop-down box, choose /dev/sda, assuming there are no other SCSI
devices in the system. Knoppix treats the SuperDisk drive as a SCSI device.

9. 

Click “OK”.10. 
The new device will appear on the Desktop.11. 
Click the icon for the SuperDisk drive.12. 
Wait while the device is mounted.13. 
Wait while the Konqueror file manager starts up.14. 
The files on the disk will be displayed.15. 
Right-click on the icon of the LS-120 drive.16. 
Click “Change read-write mode”.17. 
Click “Yes”.18. 
Drag and drop the files and folders you want to copy into the SuperDrive's window.19. 
Click “Copy Here”.20. 
The items will be copied.21. 
Close the SuperDisk's windows.22. 
Right-click on the SuperDisk's icon.23. 
Click “Unmount”.24. 
The green triangle on the drive's icon will go away.25. 
It is now safe to take the disk out of the drive.26. 

Quick help
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Question: Why does it say “Do not format” on the LS-120 disk?
All LS-120 disks are factory formatted. Simply deleting all the files on the disk will put it
back to factory fresh condition.

Networking

Connecting to a network
Knoppix has built-in support for many Ethernet network cards. As a rule, if the computer
has a network card, Knoppix will be able to support it (except the very old, or the very
new).

Well supported cards include 3Com, Realtek, NE2000 compatible, Intel and many others.
However, some Broadcom cards, found in certain Dell PCs made after the year 2000, do
not work with this version of Knoppix.

Automatic setup

If you have a supported network card, Knoppix will attempt to configure it automatically
during startup. This is for you if you have a server which manages your local area network.
To check to see if it worked:

Click the Konsole icon in the Panel (bottom row, 6th from the left).1. 
Type this command and press Enter at the end of the line:
ifconfig

2. 

This says the first Ethernet interface (eth0) has been given the Internetworking
Protocol (IP) address “192.168.1.18”. If the Ethernet card has been given an IP
address, it means the card is working.
To double-check the connection, find out the IP address of another computer on your
network. For example, suppose another computer has the address 192.168.1.1. Type
this command and press Enter, replacing 192.168.1.1 appropriately:
ping 192.168.1.1 Press Ctrl + C on the keyboard to cancel pinging.

3. 

Manual setup

If there is no server on your network, you will need to configure your network card
manually.

Click the Knoppix menu in the bottom left corner.1. 
Point to Network/Internet.2. 
Click Network Card Configuration.3. 
You will be asked if you want to use DHCP broadcast.4. 
Click “No”.5. 
You will be asked to enter the IP address that you want to give to the first Ethernet
interface. You need to know an IP address that is free on your network. You can't use
an IP address that is already in use, or both computers will not be able to
communicate.

6. 

Enter the IP address that you want to give to the card.7. 
Click OK. Follow the prompts to complete the setup process.8. 

Quick help
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Question: There is no “eth0”, why not?
Check the network cables. If there is a DHCP server on your local area network, make sure
it is running. Click the “Knoppix” menu, choose “Root Shell” and enter:

/etc/init.d/network restart
pump -i eth0

Try configuring your network card manually. If it still won't work, it may mean your
network card is not supported.

Using a network server
Knoppix can copy files to the following types of network file servers:

File Transfer Protocol (FTP) servers.
Windows Server Message Block (SMB) servers.
UNIX Network File System (NFS) servers.

Copying to an FTP server

To copy files onto a File Transfer Protocol (FTP) server:

Click the Konqueror icon in the Panel.1. 
The Konqueror file manager will come up.2. 
To log in to the FTP server anonymously, type the following on the address line.
Replace “server” with the IP address of the server you want to connect to.
ftp://server

Example:
ftp://192.168.1.1

3. 

If you need a username and password to log in to the FTP server, type the following
on the address line. Replace “username” and “password” with your username and
password. Replace “server” with the address of the FTP server you want to connect
to.
ftp://username:password@server

Example:
ftp://phil:mypass@192.168.1.1

This will connect to the FTP server at 192.168.1.1 with the username “phil” and
password “mypass”.

4. 

The files on the FTP server will appear.5. 
Drag and drop the files you want to copy to that window.6. 
Click “Copy Here”.7. 
The files will be uploaded, as long as you have permission to write files to the server.8. 

Copying to a Windows file server

To copy files onto a Microsoft Windows file server:

Click the Konqueror icon in the Panel.1. 
Wait while Konqueror starts up.2. 
Type the following on the address line. Replace “server” with the hostname or IP
address of the Windows file server.
smb://server/

3. 

Example:
smb://192.168.1.1/

4. 

The public shares on the server with the IP address 192.168.1.1 will be displayed. The
workgroup name is detected automatically. If a username and password is required,

5. 
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replace “username” and “password” below with your username and password.
Replace “server” with the IP address of the server you want to connect to.
smb://username:password@server/

Example:
smb://phil:mypass@192.168.1.1/

This will connect to the Windows file server at the IP address 192.168.1.1 with the
username “phil” and password “mypass”.

6. 

Drag and drop the files you want to copy into the server's Konqueror window.7. 
Click “Copy Here”.8. 
The files will be copied, provided you have access permission to the Windows file
server.

9. 

Copying to an NFS server

To copy files onto a Network File System (NFS) server:

Click the Knoppix menu in the bottom left corner.1. 
Click “Root Shell”.2. 
Type the following command and press Enter:
/etc/init.d/portmap start

3. 

The port mapping service will be started. The portmapper is needed to access NFS
servers.

4. 

Enter the following command, again pressing Enter at the end of the line. Replace
“server” with the IP address or hostname of your NFS server. Replace “/export” with
the name of the shared directory on the NFS server.
mount server:/export /home/knoppix/tmp

For example, to mount the shared directory “/home” to the local directory “/home
/knoppix/tmp”:
mount 192.168.1.1/home /home/knoppix/tmp

5. 

The NFS export should be mounted.6. 
Click the “Home” icon in the Panel.7. 
The files in the Knoppix home directory will be displayed.8. 
Click the “tmp” folder.9. 
The shared directory on the NFS server should appear.10. 
Drag and drop the files you wish to copy into this window.11. 
Click “Copy Here”.12. 
Given that you have the appropriate file permissions on the NFS server, the files will
be copied.

13. 

Connecting to the Internet
The main ways to get connected to the Internet are:

Through an Ethernet gateway, router or local area network.
Through an external serial modem.
Through a PCMCIA serial cardbus modem.

Knoppix is designed first and foremost for wired Ethernet networking. This gives you the
best chance of success. Meanwhile, the following connection methods may not be so easy
with Knoppix:

Most internal PCI dial-up modems.
Most external USB broadband modems.
Most wireless (802.11) PCI and PCMCIA cards.
Some PCMCIA modem/network combination cards.
AOL and Compuserve.

The above methods tend to rely on proprietary software that requires Microsoft Windows.
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Even if the proprietary software were available for Linux (which it sometimes is these
days) it cannot be distributed with Knoppix due to licence constraints.

Broadband

A broadband Internet connection lets you download at up to ten times the speed of a
conventional modem. It also lets you make and receive voice calls on the same line at the
same time. The technical name is Asynchronous Digital Subscriber Line (ADSL). To use
ADSL broadband Internet over a conventional phone line with Knoppix, you need:

A telephone line which has been “activated” for ADSL.
An account with an ADSL-enabled Internet Service Provider. This means any ISP that
offers a standard broadband service.
A microfilter for each standard analogue device (such as telephones, fax machines,
and dialup modems).
A supported Ethernet adapter in your PC or laptop (see the section “Connecting to a
local area network”).
An ADSL router. These popular, inexpensive devices combine a broadband modem
with an Ethernet router/gateway, giving “instant Internet”. The single-port variety is
for one computer. Multi-port versions let several computers share the same
broadband Internet connection.

To make the connection:

Make sure the Ethernet cable from the ADSL router is connected to the computer's
Ethernet adapter.

1. 

Start Knoppix. It should detect the network card, and then obtain an IP address
automatically from the ADSL router.

2. 

If you have not already done so, use a web browser to visit the ADSL router's
configuration page. To learn about the web browsers included in Knoppix, see the
later section, “Browsing the World Wide Web”. Enter the necessary information on the
configuration page to make the connection to your ISP.

3. 

You're done! As long as the “upstream” connection to the Internet is working, you will
be connected to the Internet.

4. 

Note
The diagram above shows a typical setup for the UK.
It may vary from country to country depending on regulatory requirements.
What is most important is that filtering must be done correctly.
The ADSL modem must never be subject to filtering, while every other device on the telephone line must be filtered.
The term “broadband” can also mean Internet provided by cable and other high speed Internet connections (including wireless options).
These connections may or may not be usable in Knoppix.

Dial-up

Dial-up Internet is the older, slower way to access the Internet. To connect this way, you
need an account with any standard Internet Service Provider (not AOL or Compuserve) and
one of the following:

An external serial modem. This type of modem connects to the computer's serial port
(called COM1 or COM2 under DOS). No special driver is needed to operate this type
of modem, so compatibility with Knoppix is excellent. For example, the “Sitecom
External V92 Serial Modem” works perfectly.
A PCMCIA Cardbus modem. A PCMCIA Cardbus modem is effectively an external
serial modem. In general, the cheaper the card, the better. For example, the “Sitecom
56Kbps Fax Modem PC Card” works perfectly with Knoppix.
An internal ISA modem. Like the external modem, this type of modem needs no
special driver to make it work. That is why old ISA modems are useful.
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There are two main ways to make a dial-up connection. The recommended way is to use “K
Point to Point Protocol” (KPPP). The alternative, in case KPPP doesn't work, is the
“Worldvisions Dialer” (WVDial).

Connecting using KPPP

Click the Knoppix menu in the lower left corner.1. 
Point to “Network/Internet”.2. 
Click “Modem Dialer”.3. 
The “KDE Point-To-Point Protocol” (KPPP) program will start.4. 
Click “Setup”.5. 
Click the “Device” tab.6. 
If your modem is plugged into the serial port called “COM1” in Windows, set “Modem
device” to /dev/ttyS0. If it is plugged into the port called “COM2” in Windows, select
/dev/ttyS1. If you have a PCMCIA Cardbus modem, select /dev/modem. If you have an
internal ISA modem, select /dev/ttyS0 first; if that doesn't work, try up to /dev/ttyS3.

7. 

Click the “Modem” tab.8. 
Click “Query modem”.9. 
You should see a response from the modem. If not, go back to step 7 and try another
modem device setting.

10. 

Click the “Accounts” tab.11. 
Click “New”.12. 
Click “Dialog setup”.13. 
In “Connection name” enter a name for the connection eg “test”.14. 
Beside “Phone number”, click “Add”.15. 
Enter your Internet Service Provider's dial-up access number. If you don't know, ask
your Internet Service Provider. Click OK.

16. 

Click OK. This will take you back to the accounts screen.17. 
Click OK again.18. 
Enter your login ID and password. Again, if you don't know what they are, ask your
Internet Service Provider.

19. 

Click Connect.20. 
You should hear the modem work.21. 
In a few moments, the KPPP window should shrink down to the Taskbar. It should
then read “00:00” on the Taskbar. This indicates your time online in hours and
minutes. Congratulations, you have connected to the Internet successfully.

22. 

To disconnect, click the KPPP button in the Taskbar.23. 
The KPPP window will come back up.24. 
Click Disconnect.25. 
The phone call will be ended.26. 

Quick help

Question: It says “The PPP daemon died unexpectedly!”
Check your username and password.

Question: I know my username and password is correct but it still says “The PPP
daemon died unexpectedly”.
Go to /etc/ppp/peers/kppp options.txt and change #noauth to noauth (ie Delete the #).

If that still doesn't help, try another modem.

Question: I tried another modem and I still can't connect.
Sorry, it seems that KPPP doesn't work with all ISPs. Luckily, there is an alternative. The
“Worldvisions Dialer” is included with Knoppix. For an example of how to use “wvdial”,
see:

http://support.real-time.com/linux/dialup/wvdial.html
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Question: Can I use an internal PCI modem?
Not usually. As noted in the “Identifying hardware” section, most internal PCI modem
cards need special software not in Knoppix.

Question: I have a PCMCIA combo Ethernet modem card, but the modem function
doesn't work.
Sorry, with some combo Ethernet and modem PCMCIA cards, only one part works. Usually
the Ethernet works and the modem does not.

Internet

Common web browsers
Once you have an Internet connection, Knoppix has several different web browsers built in.
A web browser is a program for using the World Wide Web, one of the Internet's most
popular services.

Konqueror

Konqueror is a web browser and file manager, which uses the KHTML layout engine to
render content. The WebKit layout engine used in Safari and Chrome browsers is based on
KHTML.

When starting Knoppix for the first time or with default settings into the K Desktop
Environment (KDE), Konqueror will start automatically and will display a local HTML page
introducing Knoppix.

To invoke Konqueror later on in KDE, click Konqueror Web Browser on the Panel.

Gecko-based browsers

The Mozilla Application Suite, then just known as Mozilla, has been a mainstay in earlier
versions of the Knoppix CD until Knoppix 3.8. Mozilla has not been included since that
version in favor of Mozilla Firefox. Mozilla and Firefox are both available on the Knoppix
4.0 DVD.

Mozilla Application Suite

Mozilla is a whole, integrated, configurable, sophisticated and extensible Internet
application suite. To invoke it in KDE, click the “Mozilla Browser” button on the Panel.

On modern hardware, the Mozilla Web Browser may take longer to start than Konqueror in
K Desktop Environment (KDE), because Konqueror and KDE share the same toolkit and
other technologies. On slower computers with limited RAM memory, Mozilla may be more
responsive when run from a simple window manager and not from a desktop envrionment.

Mozilla Firefox/IceWeasel

Mozilla Firefox, a fast, light browser, replaced Mozilla proper. Firefox 1.0.3 was included in
Knoppix 3.8.2 and has remained the primary browser ever since. Unlike Mozilla, which is a
whole application suite, Firefox 1.0 had an advantage with speed and responsiveness.
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Mozilla Firefox 2.0 later turned out to be comparably less responsive than SeaMonkey 1.x
— a fork and descendant of Mozilla, that was still based on original Mozilla technologies,
which had matured in 2001/2002. Firefox 2.0 also requires more in-depth customization
than SeaMonkey to make it more responsive and less resource-hungry.

The Mozilla Firefox package was later changed to IceWeasel, a version- and source-
compatible fork of Mozilla Firefox. The change was borne out of a naming and trademark
dispute with Mozilla.org and developers of Debian (on which Knoppix is based).

Since at least Knoppix 6.0.1, IceWeasel has by default included the NoScript extension,
which protects against web attacks.

Small browsers

For a minimal web browser, click K menu -> Internet -> Dillo.
For text-only web browsing (yes, really), click K menu -> Internet -> Lynx. Then hit
the letter G (for Go). You will be prompted to enter the web address that you want to
visit. Type the web address that you want, then press Enter. The web page will be
loaded.

Email
Knoppix has several different email clients. An email client is a program that lets you send
and receive Internet email. Here is how to set up the KMail email client in Knoppix:

Click the K menu in the bottom left corner.1. 
Point to “Internet”.2. 
Click “KMail (Mail Client)”.3. 
The KMail mail program will be loaded.4. 
Click the “Settings” menu.5. 
Click “Configure KMail”.6. 
The KMail configuration screen will appear. On the left side, ensure that “Identities”
is selected. Click “Modify”.

7. 

Enter your real name, organisation and email address, then click OK.8. 
Click “Network”.9. 
Click “Remove”.10. 
Click “Add”.11. 
Make sure “SMTP” is selected, then click OK.12. 
In the “Host” box, enter the hostname of your Internet Service Provider's outgoing
SMTP (Simple Mail Transfer Protocol) server. If the SMTP server requires
authentication, check the “Server requires authentication” box and enter your
username and password for sending mail.

13. 

Click OK.14. 
Click the “Receiving” tab.15. 
Click “Add”.16. 
Select the type of incoming mail server you have. Most Internet Service Providers use
POP (Post Office Protocol). Some provide IMAP (Internet Message Application
Protocol).

17. 

Click OK.18. 
Enter your login and password for receiving your email. Enter the server which
provides your incoming email in the “Host” box.

19. 

Click OK. This takes you back to the “Configure KMail” screen.20. 
Click OK again.21. 
To see if you have new mail, click the “File” menu, then “Check Mail”. Or click the
“Check Mail In” button on the toolbar. KMail will look for your new messages.

22. 

To write email, click the “Message” menu, then “New Message”. Or click the “New
Message” button on the Toolbar.

23. 
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When you have finished writing, click the “Message” menu, then “Send”. Or click the
“Send” button in the Toolbar.

24. 

Important
Knoppix will not let you accidentally run Linux programs received by email.
Program files must be given execute permission before they can be run by double-clicking on them.
This gives excellent protection against would-be “email viruses”, while still letting you open ordinary document attachments easily.

Peripheral devices

Printing
Knoppix has built-in support for hundreds of popular printers. Parallel and USB
connections are supported. The best supported inkjet printers are HP and Epson. Many
Canon and a few Lexmark printers are also supported. On the laser front, all greyscale
Postscript and most greyscale Printer Control Language (PCL) laser printers work.

However, some printers do not work with Knoppix. The printers that do not work tend to
be cheap Lexmark inkjet printers, and very low cost colour laser printers. Colour laser
printers work if they are fully Postscript or PCL compatible. Unfortunately, very low cost
colour laser printers tend not to be compatible with either. They are therefore completely
incompatible with Knoppix.

To set up a printer connected by a USB or parallel cable:

Click the Knoppix icon in the Panel.1. 
Point to “Configure”.2. 
Click “Configure printer(s)”.3. 
Wait for a moment while the KDE “Printing Manager” starts.4. 
Click “Add”.5. 
Click “Add Printer/Class…”.6. 
The welcome screen of the “Add Printer” wizard will appear.7. 
Click Next.8. 
Select “Local printer”, then click Next.9. 
Select the port that your printer is on. If your printer is connected to the computer's
parallel port, select Parallel Port #1 (/dev/lp0). If you have a USB printer, select USB
Printer #1 (/dev/usb/lp0). Click Next.

10. 

Select the manufacturer and model of your printer. If you cannot find your exact
printer model in the list, try the nearest available. For example the HP PSC 1200
driver works with the HP PSC 1350, even though the HP PSC 1350 is not in the list.
Click Next.

11. 

This screen appears if Knoppix knows of more than one driver that can operate your
printer. Usually the first or the recommended option will be fine. Click Next.

12. 

Click the “Test” button to print a test page on your printer. After a short pause, your
printer should start working.

13. 

When the test page has finished, click Next four times until you get to the “General
Information” screen. Enter a short name for your printer, then click Next.

14. 

Click Finish.15. 
The Printing Manager will be displayed again. You may now print from all the
applications included in Knoppix. When you exit Knoppix, the printer setup will be
lost. However, there is a way to save the setup. See the later section, “Finding
permanence”.

16. 
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The test page paper size is US Letter by default. If you are using A4 paper, the test page
won't print all the way to the bottom of the page. This is normal.

Web link
The Linux printing home page:
http://www.linuxprinting.org/

Scanning
Knoppix has built-in support for some scanners. Scanning in Knoppix is simple, if you are
lucky enough to have a fully compatible scanner. Scanner support is provided by a program
called “Scanner Access Is Now Easy”. If your scanner is fully supported, you don't have to
do any setup at all. To test a scanner using Knoppix:

Click K menu.1. 
Click Multimedia.2. 
Click XScanImage.3. 
If the scanner is detected, the device name will be shown at the top of the window.
For example, if you have an Epson Perfection 1260 USB, it will say Plustek:/dev
/usbscanner.

4. 

Assuming your scanner is detected, click “Preview Window”.5. 
Click Acquire Preview.6. 
The image that the scanner sees will be shown.7. 
Lasso the area to be scanned using the mouse.8. 
Click “Scan”.9. 
The marked area will be scanned to an image file.10. 

Web link
The Scanner Access Is Now Easy home page:
http://www.sane-project.org/

Sound
Knoppix has built-in support for many sound cards. Well supported cards include
Soundblaster compatibles, Creative Soundblaster Live, C-Media 8738, Intel i810, Ensoniq,
Crystal Soundfusion and the Via 82c series of sound cards.

Testing sound in KDE
Click K Menu.1. 
Point to Settings.2. 
Click Control Center.3. 
Wait for a moment while the “KDE Control Center” starts.4. 
On the left side, click Sound & Multimedia.5. 
Under Sound & Multimedia, click Sound System.6. 
On the right side, click “Start aRTs server on KDE startup”.7. 
Click Apply.8. 
Click Test Sound.9. 
You should hear the KDE startup sound.10. 
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Testing sound in XMMS
To play the built-in demonstration music file:

Click the CD-ROM icon for your Knoppix CD.1. 
Click the “Demos” folder.2. 
Click the “Audio” folder.3. 
Click the “opensource.ogg” file.4. 
Wait while the “X Multimedia System” application starts.5. 
The demonstration song will play.6. 

If the demonstration song does not start automatically, click the “Play” button (bottom row,
second from the left, in the XMMS window).

Volume controls
To adjust the sound volume levels:

Click K Menu -> Multimedia -> Sound -> KMix (Sound Mixer).1. 
The main volume control is on the far left. Move the slider up for louder and down for
quieter.

2. 

To learn what each slider does, hover the mouse pointer over the icon at the top. A little
yellow label will appear, such as “Microphone”.

Muting

The green spots are called the “mute buttons”. The mute button turns on and off output
from the corresponding channel. Light green means on, dark means off (muted). All the
channels are on by default.

Note
The microphone channel has no output, since it's only used for recording (input).
KMix gives the microphone channel a mute button anyway.
The mute button on the microphone channel has no effect.

Closing KMix

When you close KMix, it goes into the System Tray which is in the bottom right corner of
the screen. To get KMix back again, right-click its icon in the System Tray, then click
“Show Mixer Window”.

Quick help

Question: I can't get KMix to start by clicking in the K menu.
KMix is already started. Right-click its icon in the System Tray (bottom right corner of the
screen), then click “Show Mixer Window”.

Sound recording
This explains how to test sound recording through your sound card. You need a
microphone plugged in to the “Mic” socket on your sound card.
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Bring up the KMix window. If KMix is already running, right-click its icon in the
System Tray, then click “Show Mixer Window”. If KMix is not already running, click K
Menu -> Multimedia -> Sound -> KMix (Sound Mixer).

1. 

Click the red button at the bottom of the Microphone channel. This sets KMix to
record from the Microphone channel. You can only record from one channel at a time.

2. 

Click K menu -> Multimedia -> Sound -> Audacity.3. 
Wait for a moment while the “Audacity” application starts up.4. 
To start recording, click the large red circle (record) button.5. 
The waveform of the sound from the microphone will appear while it is recorded.6. 
To stop recording, click the yellow square (stop) button.7. 
To hear the result, click the green triangle (play) button.8. 

Audacity is a multi-track sound recorder. Each new recording that you make is stored in a
new track. This lets you overlay sounds on top of each other. To get rid of a recorded track,
click the small X on the left side next to the words “Audio Track”.

Web links
X Multimedia System:
http://www.xmms.org/
Audacity sound recorder:
http://audacity.sourceforge.net/

Multimedia

Playing Audio CDs
Knoppix has a built-in player for Compact Disc Digital Audio music CDs. Unlike data CDs,
audio CDs don't need to be mounted in order to be played. The ideal is to have two CD
drives in your computer – one for the Knoppix CD, and one for the audio CD that you want
to play. If you only have one CD drive, refer to “If you have only one CD drive” in the
“Advanced startup options” section.

Click K Menu.1. 
Point to Multimedia.2. 
Point to Sound.3. 
Click KsCD (CD Player).4. 
The CD player application will appear.5. 
Put the audio CD in the drive that is not occupied by Knoppix.6. 
Click the big “Play” button in the KsCD window to begin.7. 
The audio CD will be played.8. 

If your CD-ROM drive is wired to the sound card, you will hear the music through the
speakers attached to the sound card. If you can't hear anything, plug your speakers or
headphones into the audio out socket on the front of the CD drive. Then adjust the volume
level using the volume control on the front of the CD drive.

When you close KsCD, it will “dock” into the System Tray in the bottom right corner of the
screen. To get it back again, click its icon in the System Tray.

Note
Some audio CDs are designed not to work on a computer CD-ROM drive. They should be clearly marked.
They may also not work on some non-computer CD players such as in-car players.
If you are not satisfied with your audio CD, return it to the shop and ask for a refund.
It is simply cheaper and easier for the seller to give you your money back than argue.
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Playing DVD movies
Knoppix has a built-in player for DVD movies. This section will help you test a DVD-ROM
drive for DVD movie playing. It is best to have two CD drives – one CD drive for the
Knoppix disc, and one DVD capable drive for the movie disc you want to play. If you have
just a single DVD drive, refer to “If you have only one CD drive” in the “Advanced startup
options” section. You also need a reasonable graphic cards with hardware acceleration that
is supported by Knoppix. For example, the ATI Rage 128 AGP card works perfectly.

What is DVD?

DVD stands for Digital Versatile Disc. It was originally called Digital Video Disc. A DVD
disc can contain data, audio or video. DVD Read Only Memory (ROM) drives are backwards
compatible, so they can read the older Compact Disc media.

DVD movies in Knoppix

Knoppix 3.3 has a limited DVD player application. It can play "unencrypted" DVD movie
discs, such as home videos, but it can't play most commercial DVD movie discs. Knoppix
5.1 has a full DVD player which can play commercial DVD movie discs, given extra
software that has to be downloaded separately. It is best to have two CD drives: one drive
for Knoppix, and one DVD capable drive for the movie disc.

Playing DVDs in Knoppix 3.3

Click K Menu.1. 
Point to Multimedia.2. 
Point to Video.3. 
Click Xine Media Player.4. 
Wait for a moment while “Xine” starts up.5. 
The Xine player application will appear.6. 
Put the disc in the DVD drive that is not occupied by Knoppix.7. 
Click the “DVD” button in Xine.8. 
If the DVD is unencrypted, and the region check is passed, the movie should begin
playing.

9. 

If it says “Error reading NAV packet”, most likely this means the DVD is encrypted
and so it cannot be played. Try another disc.

10. 

If you need to change the region, click the Xine Setup button. When you hover the
mouse pointer over the “Setup” button, a blue spanner icon will appear in the Xine
display, and a “Setup window” tooltip will appear. Click the “Input” tab. Under
“Region that DVD player claims to be”, choose the region number that you want. For
example, choose “2” for United Kingdom (Europe). Click Apply, then Close. This
change affects only the Xine software. It will not alter your DVD drive, and it will not
affect any other DVD movie playing software that you may have.

11. 

Playing DVDs in Knoppix 5.1

Knoppix 5.1 has the magical ability to add extra software on the fly. This is handy, because
playing most commercial DVD movie discs requires installing an extra package.

Click "Knoppix" menu in the Panel (bottom row, 2nd from the left).1. 
Click "Set password for root".2. 
Enter a password of your choice. This is only a temporary password. It will be
forgotten when you exit Knoppix.

3. 

Click OK, re-enter the password, click OK again.4. 
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Gimp 2.2.8 in twm (Knoppix
4.0.2)

Start the Konqueror web browser.5. 
Visit http://download.videolan.org/pub/videolan/libdvdcss/1.2.9/deb/6. 
Click "libdvdcss2_1.2.9-1_i386.deb"7. 
Click "Open with KPackage".8. 
Click "Install". It will ask to confirm to install package "libdvdcss2", click "Install".9. 
When KPackage has finished installing, click "Done", then close KPackage.10. 
Insert the DVD movie disc.11. 
The disc will be auto-detected. Choose "Play DVD with Kaffeine".12. 
Follow the steps and the DVD movie will be played. Notice that you can skip freely.
Where many DVD players annoyingly refuse to fast forward and skip to the film, here
you can. Much better. :-)

13. 

When you exit Knoppix, the temporary installation of "libdvdcss2" will be discarded.14. 

Question: Why is libdvdcss not just included in Knoppix?
“Xine Media Player” and "Kaffeine" have not been authorised by the “DVD Copy Control
Association”. Getting authorisation is expensive and would introduce licencing constraints.
To get around that, the necessary third-party component "libdvdcss" is a separate
download.

Question: It says “Error reading NAV packet”.
The movie is probably encrypted. Knoppix cannot play it without libdvdcss.

Question: How do I know if a DVD is encrypted or not?
You don't. There is no official label. The presence (or not) of a "region code" is a guide but
not definitive. The only way to find out is to try it and see if it works.

Other applications
Knoppix includes many other useful and fun applications. There isn't space to describe
them all fully here. In this section are some of the highlights to look out for.

Graphics

The Gimp

The GNU Image Manipulation ProgramWikipedia article (The
Gimp) is a wonderful graphics editor. It is for painting,
image editing and photo retouching. Many people think The
Gimp is the greatest thing after Linux itself.

To start using it in KDE, click K menu -> Multimedia ->
Graphics -> The Gimp.
In twm, click on the desktop, hold down the mouse
button for the Main Menu and follow through Debian >
Apps > Graphics > The GIMP.

The screenshot thumbnail shows Wilber, the Gimp's mascot.
Wilber was created by Tuomas Kuosmanen, also known as
“Tiger T”. Underneath is the Gimp Toolbox, and a Brushes dialog.

ImageMagick
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ImageMagick 6.0.6 in twm
(Knoppix 4.0.2)

ImageMagick is the mainstay of classic Knoppix versions
(those older than 6.0) and typically takes less resources
than The GIMP, so resource usage depends on actual image
size.

ImageMagick contains many image editing features, which
for an advanced user manifest in the number of
command-line utilities; For common users, it uses an X GUI
for showing and changing images called IMDisplay.

Invoking

KDE: K menu > Multimedia > Viewers > ImageMagick
twm: Main Menu > Debian > Apps > Viewers > ImageMagick
From the console ImageMagick is invoked with either the display or display &
command. The latter command sequence with an ampersand & is preferable, as it
separates the ImageMagick window from the console.

Characteristics

In Knoppix, ImageMagick typically starts up with a default image and a file open dialog. To
access functions outside opening a file right away, the user must close the filepicker and
click once on the default image, which will open the Commands window.

Thus clicking on an image (not just the default image) opens or closes the Commands
window.

ImageMagick uses a very basic graphical user interface (GUI), much of which consists of
the Commands window, function menus and manipulation dialogs, all of which must be
operated with a mouse.

Clicking a function button opens a command menu, but moving the mouse cursor away or
clicking on other windows does not close menus (at least in twm). A user can have one
menu be closed by clicking on another menu button to access functions there; to close a
menu until further use, the user must click on the "Image Magick" logo in the Commands
window.

Closing an image window from a window manager also closes ImageMagick.

Caveats

In Knoppix 4.0.2 it is impossible to make screenshots with ImageMagick (or through a
command line with display) because of a bug.

Typically, screenshots can be made through File > Open > Grab, but that won't work;
editing the File Open textarea's content from /ramdisk/knoppix/x: to something else won't
help and the program will yield this error text:

unable to open image `/ramdisk/knoppix/x:': No such file or directory :
[empty space for text]

The solution is to use either of the following alternatives in order of resource usage (the
list is slightly subjective):

KSnapshot, which uses underlying libraries of KDE and its framework. Invoked
through

KDE: K Menu > Graphics > Screen Capture Program
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twm: Main Menu > Debian > Apps > Graphics > KSnapshot
Command line: ksnapshot &

The GIMP;
and —

X Window Dump

X Window Dump, or xwd for short, is a command-line app for making screenshots. Being
the least resource-intensive of all, it dumps an image of either a targetted window or the
whole screen. The simplest way to invoke the program:

xwd -out imagename.xwd &

This changes the mouse cursor to a crosshair pixmap for targetting a window or a free
area (the desktop) for the whole screen. The dumped screenshot can then be converted to
PNG with ImageMagick. For more on xwd and making PNG screendumps from the outset,
see Starting Sessions#Making screenshots from the Guide to X11 wikibook or the xwd
man page.

In twm, one can write the command in the rxvt console whilst not yet executing it, then
iconify the rxvt window and move its icon to an accessible area. The user can then bring up
a desired visual setup for the screenshot, move the mouse over the rxvt icon (and not
de-iconify it) and then press enter.

This works by way of an rxvt window being able to receive input even when iconified, with
the mouse cursor hovering above the icon either on the desktop or in the TWM Icon
Manager. — Such behaviour in Knoppix has been observed to be specific to rxvt only.

Caveat

In Knoppix 4.0.2, xwd is unable to capture the main OpenOffice.org window or the root
window showing the main OO.o window, if screen color depth for Knoppix has been set to
16 bits (65,536 colours) with the depth=16 startup parameter. Attempting to make a
screenshot at that color depth will yield an error. This may be because of OO.o's use of
gradients in its user interface.

The solution is to try to make a screenshot with GIMP or to run Knoppix with color depth
of at least 24 bits; monitor and video adapter combinations not supporting such a set-up
are few and far between.

Office applications

OpenOffice.org office suite

OpenOffice.org is the slowest but most powerful office application in Knoppix.
OpenOffice.org combines word processing, spreadsheets, presentations, drawing, and
databases in one huge package.

On older computers, OpenOffice.org versions 2.x and earlier may take several minutes to
start, because the application takes its time loading language aids (dictionaries and
thesauri). Every successive version of the package has more language aids with it.

For instructions on how to disable writing aids and other optimization tips, see the
Performance Tips chapter from the OpenOffice.org book.
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OpenOffice.org 1.1.3 in a
setup similar to Knoppix 3.7
(Mandriva Linux
10.1Mandrakelinux at the time)

As part of framework changes, language aids are integrated
in the form of separate extension modules with OO.o 3.0
and later and language modules' default amount reduced as
a result (as usual, every language-specific installation of
OO.o still includes the modules specific to its respective
package).

Starting with Knoppix 6.4.3, the distribution has switched
to LibreOffice, a functionally equivalent fork of
OpenOffice.org.[1]

Invoking

To begin using OpenOffice.org:

In KDE

Click K menu -> Office -> OpenOffice.org -> OpenOffice.

In twm

In Knoppix 4.0.2, OpenOffice.org is absent from the default menu; This means that other
window managers in Knoppix lack the relevant menu hooks, too. A user can start OO.o
from the command line, or rectify this situation by adding the following preformatted text
to the local .twmrc file:

• Add text (boldfaced here for emphasis) into the section (within curly brackets) of the
Debian submenu:

menu "/Debian"
{
  "Apps" f.menu "/Debian/Apps"
"OpenOffice.org" f.menu "/Debian/OOo"

  "Games" f.menu "/Debian/Games"
  "Help" f.menu "/Debian/Help"
  "Screen" f.menu "/Debian/Screen"
  "System" f.menu "/Debian/System"
  "XShells" f.menu "/Debian/XShells"
}

• Then add the following (avoid pasting inside other menu sections):

menu "/Debian/OOo" {
"Writer" f.exec "soffice -writer -nocrashreport &"
"Web" f.exec "soffice -web -nocrashreport &"
"Calc" f.exec "soffice -calc -nocrashreport &"
"Impress" f.exec "soffice -impress -nocrashreport &"
"Math" f.exec "soffice -math -nocrashreport &"
"Global" f.exec "soffice &"
}

^ Using the -nocrashreport flag for soffice alone causes OO.o to launch with Writer; -global or
-nodefault command-line flags are thus not necessary.

In a computer environment with a limited amount of useful (RAM) memory, using the
-nocrashreport command-line option disables invoking the crash reporter, if it happens that OO.o
crashes and OO.o's document recovery mechanism and crash reporter are invoked at next
program start.

The crash reporter would ask for confirmation to send crash data to Sun Microsystems
(acquired by Oracle in 2010). If the crash reporter does appear, then it's best not to send
crash data, because Knoppix has moved away from OpenOffice.org to LibreOffice and it's
pointless to send crash data about earlier OO.o versions.
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Gnumeric 1.6.3

• Save .twmrc and restart twm.

Command line

soffice [-writer|-web|-calc|-impress|-math] [-nocrashreport] &

^ Flags in square brackets to start different OO.o apps are optional.

KOffice

KOffice is a simple office suite, for word-processing, spreadsheet, drawing, presentations
and other tasks. Unlike OpenOffice, KOffice is quick to start. To begin, click K menu ->
Office -> KOffice, then click the program you would like to use.

KOffice is present in Knoppix versions of up to 3.1–3.3 and 4.0.2–5.3.1. CD variants of
these versions of the distribution might not contain it.

Gnumeric

Gnumeric is a powerful standalone spreadsheet application.
Like KOffice, Gnumeric is quick to start. To begin, click K
menu -> Office -> Gnumeric.

Gnumeric is present in Knoppix versions up to 3.1–3.3;
4.0.2–5.3.1 and 6.2.1–6.4.4 (the latest version). Modern CD
variants might not contain it.

AbiWord

AbiWord is a simple word standalone processor. To get
started, click K menu -> Office -> AbiWord word processor.
Compared to OpenOffice Writer and KOffice, abiword is lighter with less bloat.

Wine
Wine is an application compatibility layer that allows programs written for Windows to run
in Linux. Its self-explanatory meaning has become a recursive backronym, which is Wine Is
Not an Emulator.

Knoppix has typically included a contemporary snapshot of the program's releases, which
are more outdated with every older version of the distribution. While Wine can run a large
variety of Windows applications, then there are some that won't run with it, and some apps
that may run with varying degrees of success.

Invoking

One way to invoke a Windows program though Wine is through the command line:

$ wine /path/to/application.exe &

Assuming an existing Windows installation on a hard drive, programs can be run from
there by mounting the hard drive:
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Wine Launch Window.
Wine v.20050725 at Knoppix
4.0.2

$ mount /mnt/hda1

and then invoking Wine to run an application originally made for Windows:

$ wine "/mnt/hda1/Program Files/K-Meleon/k-meleon.exe" &

^ Because the Program Files folder contains a space, the
whole path must be surrounded with double quotes.

In either case, the Wine Launch Window will start, to notify
the user of the activity. The launch window can be set not to
be shown in the future when invoking Wine.

If Wine hasn't been run before, the Wine launch processes
create necessary configuration folders and support files and
then launch the requested application (the K-Meleon
browser in this case).

After exiting a Window program, Wine will show either a status message that the program
closed with success or an error message. A number of seconds may pass between the
apparent program exit and the status message.

Caveats present in Knoppix 4.0.2

Depending on a version of Knoppix, Wine might or might not be included in the default
menu file.

The following are caveats specific to Knoppix 4.0.2. Wine version 20050725 is a pre-beta
release and running Windows software with that may not be easy:

The Wine menuitem is not in the default menu file in Knoppix 4.0.2;
Shortcut menus of programs that use the native Windows widget toolkit are
inaccessible; Commands from the menu bar can only be accessed classic Mac-style:
by clicking on a menu item and holding the mouse button down the menu to reach and
invoke a command. (This has been observed in the twm window manager.)
Standard text find functionality does not work, while alternative implementations do
(examples are various find bars);
Some newer applications' functionality is hampered: For example, the URL bar in
K-Meleon 1.5.4 is not functional — URLs can be entered by editing bookmarks and
then accessing those.

Non-permanence

After using a Windows program through Wine, saving the configuration and restarting the
computer with said configuration, launching Windows programs becomes impossible
because of very slightly corrupted file paths. A workaround is to delete the .wine
configuration directory in the local user folder:

knoppix@[knoppix]$ rm -r -f .wine

^ Where: rm (remove) is the delete command, -r stands for recursive (deletes the folder), -f
stands for force [delete], which does not ask for confirmation before deletion (therefore no
verbosity).

— After that, it's possible to run the programs again but any Wine settings are then also
deleted.
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The result of setting the
default Wine font right,
where a Windows program's
user interface font looks
normal

Font issues

By default, Windows programs' UI texts are displayed in a font called Adventure, which is
shown in small type, and is ugly and unsuitable for use in user interfaces. This is because
of a bug in Wine, which has been fixed in later versions, but software on a Live-CD
distribution is static and therefore requires a workaround described below.

Upon starting a Windows program for the first time, Wine creates Windows-like support
directories and files, along with the Windows fonts directory in the virtual "C" hard drive,
the path of which in Knoppix is:

/home/knoppix/.wine/drive_c/windows/fonts

The above windows/fonts directory is empty and Wine defers to a fallback font, which for
some reason is Adventure.

A usual way to solve this issue on permanent Linux installations is to populate the
directory with standard fonts, either those made specifically for Windows or with
substitutes.

Because of a Live CD's typically non-permanent nature and above caveats, the workaround
for a normal user interface font is to create a symbolic link for windows/fonts to a specific
font directory created in Linux, but all this is effective only after .wine configuration and
support folders and files have been created by running a Windows executable for the first
time. Symlinking to a font directory goes like this:

$ ln -s /usr/share/fonts/truetype/ttf-bitstream-vera .wine/drive_c/windows/fonts

^ The dollar $ sign is traditionally the command-line marker; ln is the linking command, -s
stands for symbolic, the first path is the target path, the second path is the one from which
the target is linked to. The symbolic link can be removed in the fonts directory with a simple rm
command.

If a user is consistently using Knoppix 4.0.2 with the
configuration saving method, then they can add a command
sequence with the above command into their window
manager menu file, especially because of the
non-permanent nature of Wine configuration data.

The following complex, yet handy, example set of commands
for the twm window manager assume the presence of an
existing hard drive and a Windows installation on it. The
sequence of commands first mounts the hard drive, then
starts Wine, which will create support folders and files to
launch a screen saver, and then links the actual font folders.
The Blank Screen screensaver is one of the smallest
possible native Windows apps to close with the least
amount of user input (moving a mouse cursor in the screen
saver window), which means that the program will close
almost by itself.

The highlighted part of configuration text is to be added:

menu "/Debian/System"
{
"Security" f.menu "/Debian/System/Security"
"" f.nop
"Set Wine font" f.exec "mount /dev/hda1; wine \"/mnt/hda1/windows/system/Blank Screen.scr\" \/s && ln -s /usr/share/fonts/truetype/
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}

^ The f.nop line following Security inserts a line break. mount /dev/hda1 mounts the hard drive. The
colon ; ensures that the next command is started only after the previous command has been
completed. Because Blank Screen.scr contains a space, the whole path to it must be wrapped in
double quotes; these, in turn, must be escaped with a backslash \ so as not to break the
command sequence. The /s option starts the screensaver and not its configuration applet; As
the option's trigger character is a forward-slash, which serves to separate directory names in
Unix and like systems, then it's also escaped with a backslash \ just to be on the safe side.
Double ampersands && serve to execute one and another command, and the last ampersand
ensures the command or command sequence separates from its originator.

Settings specific to TWM

Twm is a window manager, which by the standards of today and at least 21 years back(as of

2011) exhibits non-standard behaviour for a windowing environment, where a program
window is rendered only after the user has specified its location by moving the window's
skeleton crosshairs to a desired place on the screen and then clicking the main
mouse/pointer button.

The following instructions are meant to reduce the amount of user input when
running Wine and setting up fonts for it

First off, after launching Wine to run a Windows program, Wine will invoke the Wine
Launch Window and then the Windows program itself. This is two instances of moving a
pointer and clicking the primary button, which makes four movements. And setting the
font right in Knoppix 4.0.2 beforehand will total eight movements.

One workaround is to click the "Never display this message again" button in the Wine
Launch Window. The button is self-explanatory.

Nevertheless, the Wine Launch Window also serves the purpose of showing launch status
of Wine and some users might want to keep seeing it appear.

Avoiding window skeleton crosshairs by specifying window geometry won't work with
Wine, because Wine launches more than one window, and at least one of them is not native
to X.

The workaround is in twm's .twmrc config file to have the Wine Launch Window start in
iconified form:

StartIconified {
"Wine Launch Window";
}

This will remove the need for the user to place the launch window somewhere. (More
windows can be in each following line added by specifying the exact window title or app
command with the same syntax.)

Secondly, when setting user interface fonts right for Wine-run apps, a screen saver
program is used to invoke Wine itself (See Font issues above). Because it's a screen saver,
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Frozen Bubble screenshot

it requires the least amount of user input to quit the app, which is why it won't require a
title bar (for some reason, attached to the screen saver by default), so as to have the least
distance between the cursor and the screensaver proper to dismiss it in nearly a click. The
NoTitle setting for the screen saver window in the .twmrc file applies here:

NoTitle {
"Screen Saver";
}

The user then clicks to render the screen saver to just move the mouse cursor southeast to
close the applet. This should take only a second or two.

Toys and amusements

KStars planetarium

KStars shows the position of the stars and planets in the sky in real time. KStars can show
the view of the sky from hundreds of locations around the world. It also has a catalogue of
planets, stars and other objects. To start using KStars, click K menu -> Entertainment ->
Science -> KStars.

Frozen Bubble

Frozen Bubble is an arcade style bubble bursting game for
one or two players. The idea is to hit two or more other
bubbles of the same colour to make them disappear. To
start, click K menu -> Games -> Tetris-like -> Frozen-
Bubble.

KSokoban

KSokoban is a gemstone-pushing puzzle game. The object of
the game is to move the red diamonds onto the green
squares, only by pushing the red diamonds. Move the man
using the cursor keys. To begin, click K menu -> Games ->
Tactics & Strategy -> KSokoban.

GTans

GTans is a shape-building puzzle game. Move, rotate and flip the shapes to make the larger
shape shown on the right hand side. To start, click K menu -> Games -> Puzzles -> GTans.

Installing Applications not included on
the CD

About UnionFS

Starting with Knoppix 3.8 and higher, there is a new feature included and enabled by
default called UnionFS. This enables ANY file on the filesystem to be changed, and when it
is the new file is stored on the RAMdisk, and the system knows not to refer to the "old"
version of the file on the CD.
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This feature is important to allow you to add software that is not included with the Knoppix
distribution easily while running the system from any Internet connected computer (high
speed connection recommended).

Installing Packages

You will be using the standard debian packaging tool, apt-get. Don't worry, apt-get is really
easy to use.

First, go to a command prompt with konsole and type in:1. 

sudo apt-get update

What this does is update the listing of available packages. "sudo" runs the command
as the super-user, which must be done when working with apt-get.

1. 

Next, find the package you want. You can find a searchable listing of all packages
available for debian at:

2. 

http://packages.debian.org

After finding your package, type in at the konsole prompt:1. 

sudo apt-get install packagename

where "packagename" is replaced with the name of the package you want to install.

As an example, say you want to work with the kdegames package (which includes all the
games included by default with the K Desktop Environment). FYI, this package includes a
wide range of games, from remakes of classic arcade games, board games, as well as card
games.

All you have to do is type at the prompt:

sudo apt-get install kdegames

Miscellaneous Notes

You are limited in the amount of packages you can install by the amount of your physical
RAM. When you run apt-get, it will tell you the amount of space the packages take up.
Watch how many packages you install, if you have 256 MB of RAM it's probably not wise
(but may be possible) to install about 230 MB of packages.

If the lack of packages on the CD concerns you, don't worry. There is now a Knoppix Live
DVD, which includes over 9 gigs of software (uncompressed) on the DVD... All your favorite
packages are likely included on this DVD!

To install more than one package, simply put a space between each package you want to
install, like this:

apt-get install kdegames planetpenguin-racer gnome-games bsdgames

Note to all debian users. Anyone who has used debian before will probably be itching to
issue
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apt-get upgrade

You are urged not to do this as knoppix has many custom scripts that apt-get upgrade
seems to break.

References

Bodnar, Ladislav (2010-12-24). "Distribution Release: KNOPPIX 6.4.3". Distrowatch.
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1. 

Recovering from freezes
It is possible for the X Window System, the K Desktop Environment, or an individual
application to "freeze up". This section explains what to do if that happens.

Getting rid of an individual application

The most common situation is to have a program that just doesn't seem to want to go away.
Even when you click the close button on its window, it still won't disappear. To get rid of it:

Press Ctrl+Alt+Esc on the keyboard.1. 
The pointer will change into a skull and crossbones.2. 
Point anywhere inside the window that you want to get rid of.3. 
Click the left mouse button.4. 
The errant program will be killed.5. 

Restarting the X Window System

If many programs or your entire graphical environment seems stuck, you can try to restart
the X server entirely.

Pressing Ctrl-Alt-Backspace kills X. The display manager should bring it back up again.

An alternate way to restart X in Knoppix is to:

Press Ctrl+Alt+F2.1. 
Type this command, then press Enter:
init 2

2. 

You will see the message "X Window System shut down". This will also end the K
Desktop Environment and all its open applications.

3. 

Then enter:
init 5

4. 

The X Window System will be restarted. The KDE desktop will appear again as it did
when you first started Knoppix.

5. 

Getting help
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“Where's the 'Any' key?” -- Homer Simpson

How to get help

On the CD

The Knoppix CD carries the official list of frequently asked questions and answers. It is
provided in several languages. To read the English version:

Click the CD-ROM icon for your Knoppix CD1. 
Click the “KNOPPIX” folder.2. 
Click the “KNOPPIX-FAQ-EN.txt” file.3. 
Wait for a moment while the “KWrite” application starts.4. 
The English version of the “Frequently Asked Questions” file will appear.5. 

From the Web

See the “unofficial” Knoppix web site for further FAQs, user forums, and how to get the
latest version of Knoppix.

Web link
The site for users, developers, and testers of Knoppix
http://www.knoppix.net/

By email

There is a mailing list, which is for development of Knoppix. The discussions are in German
and English.

The mailing list homepage is:

http://mailman.linuxtag.org/mailman/listinfo/debian-knoppix

The archives are at:

http://mailman.linuxtag.org/pipermail/debian-knoppix/

With Internet Relay Chat

Links

Simplified: irc://freenode/knoppix
Full: irc://chat.freenode.net/#knoppix

How to

If you are looking for somewhat instant answers, Internet Relay Chat (IRC) is the place to
be. To talk to other Knoppix users using IRC:

Make sure you are connected to the Internet.1. 
Click K Menu.2. 
Point to Internet.3. 
Click X Chat.4. 

Knowing Knoppix/Print version - Wikibooks, open books for an open world

56 von 71



Wait for a moment while the “X Chat” application starts.5. 
In the Nick Names boxes, enter up to three nicknames which you would like to be
known as. You must enter at least two nicknames, in case your preferred nickname
happens to be in use when you join the chat server.

6. 

In the Username box, enter the username or login which you use to connect to your
Internet Service Provider.

7. 

In the Real Name box, type your real name.8. 
Under “Networks”, scroll down to “Freenode”.9. 
Click “FreeNode”.10. 
Click “Connect”.11. 
The message of the day from the IRC server will be shown.12. 
Type the following command and press Enter:
/join #knoppix

13. 

You will be joined to the “#knoppix” IRC channel. The messages in the channel will
appear on the left. The nicknames of the people who are in the channel will be shown
on the right.

14. 

Ask your question, remembering to spell and punctuate correctly. The other IRC users
will do their best to help you. Enjoy the chat!

15. 

Tip
Before using IRC, check to see if your question is already answered in the Frequently Asked Questions.
Knoppix users would love to see more people using IRC.
However, if you ask a question that is already answered in the Frequently Asked Questions, you may be told to look there - or maybe s

Making X Chat fonts larger

If you find the writing too small in X Chat:

Click the “Settings” menu at the top of the X Chat window.1. 
Click “Preferences”.2. 
Next to “Font”, click “Browse”.3. 
Choose the font size you would like to use.4. 
Click OK.5. 
Click OK.6. 
The fonts will change to the size you chose.7. 

Finding permanence

Finding permanence
“The box said that I needed to have Windows 98 or better… so I installed Linux.” --
LinuxNewbie.org

Overview

Knoppix lets you store personalised settings, document files and system settings on a disk.
This saves you from having to set up Knoppix from scratch every time you run it.

Important: The functionality described in this article is available only until and including
Knoppix 5.1.1 (CD release) and 5.3.1 (DVD release), as all versions of Knoppix since 6.0
don't have it anymore.
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Knoppix 6.x releases require saving all of the CD or DVD contents to non-optical media
(hard disk, flash drive, memory card), from which to boot the system up. Note that some
computers are not configured or able to run operating systems off USB-connected drives or
memory cards; some other systems won't boot from very large external storage items. The
boot order is configured from the BIOS, access to which may be restricted in some
situations (typically computers at and supplied by workplaces).

Creating a persistent Home directory

Personalisation is what makes your computer yours. Personalised settings include
application preferences, for example, your favourite KDE background wallpaper.
Documents are the files that you create using Knoppix applications, such as graphics and
word processed document files. Personalised settings and documents are stored in a
special place called your Home directory.

Knoppix lets you keep your Home directory on another disk. This is called creating a
persistent Knoppix home directory. It allows you to use a personalised Knoppix account
everywhere you go. For example, you can sit down at one computer, do some work, go to
another computer, and carry on working.

This works best with a USB hard drive stick, also known as a USB flash drive. These
marvellous little gadgets give you hundreds of megabytes of storage, in a space no bigger
than a key fob. A USB flash drive is the ideal companion to a Knoppix CD. To create a
persistent Home directory on a USB flash drive:

Insert your USB flash drive.1. 
Wait for a moment while the drive is detected.2. 
A new hard disk partition icon will appear on the Desktop.3. 
Note the name of the new icon. For example, if there are no other SCSI drives in the
computer, it will be labelled “Hard disk partition [sda1]”.

4. 

Right-click on the USB flash drive icon.5. 
Click “Mount”.6. 
Right-click on the USB flash drive icon again.7. 
Click “Change read/write mode”.8. 
It will ask if you want to make the partition writeable.9. 
Click “Yes”.10. 
Click the Knoppix menu in the Panel.11. 
Point to “Configure”.12. 
Click “Create persistent KNOPPIX home directory”.13. 
Click “Yes”.14. 
Choose the partition that corresponds to your flash drive. In this example, /dev/sda1
represents the flash drive.

15. 

You will be asked if you want to encrypt the file that will be created on the flash drive.
This is optional, so click “No”.

16. 

Enter how big in megabytes you would like your Knoppix home directory to be. For
example, enter “100” for 100 megabytes. Imagine you have a 256 Mb flash drive. This
will create a 100 megabyte file on the flash drive, leaving 156 Mb free for other files.

17. 

Click OK.18. 
Wait while Knoppix prepares the flash drive. If the flash drive has an activity light, you
will see it working for a few moments.

19. 

You will be asked if you want to use the entire partition. Click “No”. This will leave
existing files on the flash drive alone.

20. 

Wait while Knoppix completes the setup process.21. 
Knoppix will tell you what you need to type at the boot prompt to use the persistent
Knoppix home directory on your flash drive. Make a note of what it says, then click
OK.

22. 

You must reboot for the change to take effect. Shut down Knoppix and restart. At the boot
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prompt, type the following command, replacing “sda1” as appropriate:

knoppix home=/mnt/sda1

During startup you should see a message like this:

Mounting /mnt/sda1/knoppix.img as /home/knoppix...
/home/knoppix mounted OK.

This means it worked. The USB flash drive will now be used for the home directory of the
“knoppix” user.

Important
With a persistent home directory on a flash drive, the flash drive will be in use all the time.
Do not take the flash drive out until you have shut down Knoppix.

Saving system settings

Saving system settings is called making a Knoppix configuration archive. This stores
settings that are saved in the system-wide configuration directory, not in the home
directory. For example, it allows you to save your printer setup, so you don't have to do it
again next time. To save the system settings:

Click the Knoppix menu on the Panel.1. 
Point to “Configure”.2. 
Click “Save KNOPPIX configuration”.3. 

Select the system settings that you would like to store.4. 

Personal configuration. If you have a persistent Knoppix home directory, you do not need
this. If you do not have a persistent Knoppix home directory, this option covers the
personalised settings you have made in programs like the KDE Control Center, and your
personalised settings in applications such as AbiWord. It does not include document files,
such as saved word processor files. It also does not include cache files from web browsing.

All files on the Desktop. If you have a persistent Knoppix home directory, you do not
need this. If you do not have a persistent Knoppix home directory, select this option to save
the new disk icons or program icons that you may have created on the Desktop.

Network settings. If you have a persistent Knoppix home directory, and all you are doing
is using the KPPP dialler to connect to the Internet via a modem, you do not need this.
KPPP configuration is saved as part of your Knoppix home directory.

The network settings saved by this option include Local Area Network (LAN), manually
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configured dial-up networking (modem), Integrated Services Digital Network (ISDN) and
Asynchronous Digital Subscriber Line (ADSL) settings. For example, if you have set up
your network card manually, select this option to save the configuration for next time.

Graphics subsystem settings. This saves settings for the “X Window System” (the
graphics display). For example, if you specified a certain screen resolution when you
started Knoppix, this option will save that setting.

Other system configuration. This option saves the printer setup and all other
system-wide settings.

Click OK.1. 
Select the device that you would like to save onto. For example, assuming you have a
USB flash drive, and there are no other SCSI drives in the system, choose /mnt/sda1.

2. 

Click OK.3. 
Wait while the archive is created.4. 

If it worked, it will say, “Creation of the KNOPPIX configuration archive was
successful”. It will tell you the command to use at the boot prompt to load the saved
settings.

5. 

Click OK to exit.6. 

To load the saved settings next time you start Knoppix, use the “myconfig” parameter at
the boot prompt. For example, assuming you saved the archive to “/mnt/sda1”, at the boot
prompt enter:

knoppix myconfig=/mnt/sda1

If it works you will see something like this near the end of the startup messages
(Ctrl+Alt+F1):

Checking /mnt/sda1 for KNOPPIX configuration file...
Found, now executing /mnt/sda1/knoppix.sh
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Advanced startup options
“There is only one satisfying way to boot a computer.” -- J. H. Goldfuss

Overview
This section explains the bootup options for Knoppix. Use these options to fine-tune
Knoppix for your hardware and speed it up.

Enabling DMA
The first and foremost way to make Knoppix run faster that almost everyone can use is to
enable DMA. It stands for Direct Memory Access. It improves the speed of hard disk drives
and it can also help CD-ROM drives. DMA is not supported on all computers, so Knoppix
turns it off by default. To enable DMA, add 'dma' to your boot command, for example:

knoppix lang=uk dma

To test the speed of the hard disk drive, click the Knoppix menu, choose “Root Shell” and
enter:

hdparm -t /dev/hda

Replace “hda” with the device name of your hard drive appropriately. After a pause of
about 3 seconds, you will get a little report that will tell you how fast your hard drive reads
data. DMA makes a pretty big difference. For example, look at these sample test results:

Drive Without DMA With DMA

Seagate Barracuda 7200 RPM IDE 8.5 MB/sec 26.8 Mb/sec

If you only have a single CD drive
Knoppix takes over your CD drive and you can't eject it during your session. What if you
want to use the CD drive for something else? For example, you may want to create CDs
using a CD-ReWritable drive. If you only have one CD drive, this will be a problem.

Luckily, there is a solution. It is possible to run Knoppix from a hard drive or RAM, freeing
up the CD drive for other tasks.

Transferring to a hard disk partition

Transferring to a hard disk partition means copying the CD contents onto a hard disk. This
is called “copying the CD image”. Once this is done, Knoppix starts in the normal way but
from the hard drive instead the CD-ROM drive.

This gives improved performance, because hard disk drives are generally much faster than
CD-ROM drives. It also frees up your CD-ROM drive for other tasks. It does not affect the
existing files on the hard drive. All it does is use up hard drive space, which can be
reclaimed later.

To transfer to a hard disk partition, you need:
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An MS-DOS, FAT or Linux formatted hard disk partition.
NTFS (native Windows NT/2000/XP) partitions cannot be used.
At least 700 Mb free space on the partition.

At the boot prompt, enter this command. Replace “device” with the device name of the
hard disk partition that you want to use.

knoppix tohd=device

For example, suppose you have Windows 98. You probably have Windows installed on the
first partition of the primary master IDE drive. In this case, use:

knoppix tohd=/dev/hda1

Knoppix will start from CD, copy itself to the specified device and then continue loading
from there. You can then take the Knoppix CD out of the drive.

Re-using an existing image

You only need to copy the CD image to the hard disk once. Next time, you can read back
from the hard disk, without having to copy the CD image again.

At the boot prompt, enter this command. Replace “device” with the device name of the
hard disk partition where the Knoppix CD image is located.

knoppix fromhd=device

For example:

knoppix fromhd=/dev/hda1

Knoppix will start from CD, pick up the CD image from the specified device and continue
loading. You can then take the Knoppix CD out of the drive.

Deleting the image

In Windows, remove the “KNOPPIX” directory from the hard drive using Windows
Explorer. This will give back the hard drive space occupied by the CD image.

Transferring to RAM
If you have 828 Mb or more of RAM, you can copy the Knoppix CD image to RAM. After an
initial wait, transferring to RAM gives dramatically improved performance, and the
Knoppix CD is not needed. You need 828 Mb of RAM because the first 700 Mb is used for
the CD image. The remaining 128 Mb is used for the system and applications.

At the boot prompt, enter this command:

knoppix toram

Knoppix will start from CD, transfer the CD image to RAM, and continue loading. Once
transfer to RAM has completed, you can take the Knoppix CD out of the drive.

Knowing Knoppix/Print version - Wikibooks, open books for an open world

62 von 71



More hardware options
These options let you fine-tune Knoppix for your particular hardware. They can be
combined in any order. For example, to start Knoppix with the US language/keyboard, a
wheel mouse, a screen resolution of 800x600 and Direct Memory Access (DMA) enabled
for hard drives, type this at the boot prompt:

knoppix lang=uk wheelmouse screen=800x600 dma

Knoppix assumes you have a laptop. It starts up with PCMCIA (credit card adapter)
interface support enabled by default. If you have a desktop computer, rather than a laptop,
you can improve performance slightly by typing the “nopcmcia” option at the boot prompt.
For example, to start the computer with the US locale, a wheel mouse, a screen resolution
of 1024x768, and no PCMCIA:

knoppix lang=us wheelmouse screen=1024x768 nopcmcia

If you have less than 128 Mb RAM
After loading the kernel and the base system, Knoppix looks to see how much RAM is left.
The kernel and the base system takes about 20 Mb of RAM. The remainder is called free
RAM, or available RAM.

Knoppix checks to see if there is a Linux swap partition available. You may have a swap
partition if you have previously installed Linux on the hard disk. If so, Knoppix will use the
existing swap partition automatically.

If there is less than 80,000 Kb free RAM, Knoppix will prompt you to create a swap file. A
swap file lets you use part of the hard disk as if it were RAM.

This trick lets you run Knoppix in full, even when you have less than 128 Mb RAM. For
example, it is possible to run Knoppix successfully on a computer with only 64 Mb of RAM.
However, you pay a performance penalty, because swap is much slower than physical RAM.

To create a swap file, you need a hard disk with at least one partition that is formatted with
the FAT filesystem. NTFS formatted partitions cannot be used.

Start Knoppix in the usual way.1. 

You will get a message that says, “There are only X Kb of RAM available in your
computer”.

2. 

Press Enter.3. 
Knoppix will search for an available FAT formatted partition. If there is more than one,
Knoppix will choose the last available partition. You will be asked if you want to create
a swap file on the partition that Knoppix has selected.

4. 
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Using the arrow keys on the keyboard, choose “Yes”, then press Enter.5. 
You will be asked how big a swap file you want to create. You need a swap file that is
large enough to take the free RAM + swap file total to at least 80,000 Kb.

6. 

Type the size of the swap file you wish to create. In this example, it says there is
49,152 Kb of physical RAM free. The suggested swap file size of 60 Mb will bring the
free total to 108 Mb.

7. 

Press Enter.8. 
Wait for a moment while Knoppix creates the swap file.9. 

Press Enter to continue loading Knoppix.10. 

Tip
Next time you start Knoppix, it will detect and use the swap file automatically.
To remove the swap file and reclaim the disk space it occupies, exit Knoppix, start
Windows, then delete the file called “knoppix.swp” using Windows Explorer.

Alternatives to KDE

Alternatives to KDE
Knoppix has six alternative desktop managers. These let you run the X Window System on
a computer that doesn't have enough RAM for KDE. They also save loading time, because
they load much more quickly.

Ice Window Manager

A small and fast window manager in the Microsoft Windows style.
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Ice Window Manager screenshot

Window Maker

A simple and elegant window manager with a very solid feel.

Window Maker Window Manager screenshot

Fluxbox

Similar in style to Window Maker.
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Fluxbox Window Manager screenshot

Xfce

Xfce stands for “The Cholesterol Free Desktop Environment”.

Xfce Desktop Environment screenshot

Lars Window Manager

An alternative window manager. In Lars Window Manager, almost everything is done with
the keyboard instead of the mouse. Lars Window Manager is designed for programmers
that spend most of their time working with text.
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Tab Window Manager screenshot

Lars Window Manager screenshot

Tab Window Manager

See also: Guide to
X11/Window
Managers/twm

TWM is designed to
use as little RAM as
possible. If you start
Knoppix on a
computer without
enough RAM to run
KDE, it will run Tab
Window Manager
instead.

In Knoppix 5.0.1, the
twm menu is missing,
but a command line
(console) window does
start. With a capable
computer (at least 256
Mb RAM), the easiest
shortcut to an app
launcher is KDE's
Kicker. Invoke it like
this:

$ kicker &

^ The dollar sign $ is the default sign of the command line; the ampersand & serves to
separate Kicker from the console to free it up for other uses. The screenshot to the right
shows the same method with The GIMP.
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TWM does not appear to be included in CD versions of Knoppix 6.0 or later, as these have
solely defaulted to LXDE. That won't run with any efficiency in computers that have less
than 256 Mb of RAM memory.

Starting an alternative window manager
once knoppix has loaded you can go through the configuration options, to switch between
various window manager(except beryl).

Use one of these commands at the boot prompt.

knoppix desktop=icewm          # IceWM
knoppix desktop=wmaker         # Window Maker
knoppix desktop=fluxbox        # Fluxbox
knoppix desktop=xfce           # Xfce
knoppix desktop=larswm         # Lars Window Manager
knoppix desktop=twm            # Tab Window Manager
knoppix desktop=beryl          # Beryl with kde

For example, to start Window Maker in the UK locale:

knoppix desktop=wmaker lang=uk 

Accessing disks and partitions while outside KDE

You may have noticed there are no desktop disk icons when you are using an alternative to
KDE. Luckily, you can still use KDE's disk management tools, even when you are outside
KDE. For example:

Start Knoppix into Window Maker.1. 
Click the “XTerm” icon, which is on the right hand side, second from the top. Enter
this command:
kdf

2. 

Wait while “KDiskFree” starts.3. 
Right-click the icon of the disk or partition you want. Click “Mount”. Right-click the
icon again, then “Open in file manager”.

4. 

The files on the disk or partition will be displayed.5. 
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Important: KDiskFree mounts in read-write mode, not read-only.

Text mode

Text mode is the fastest way to start Knoppix. Text mode is meant for those who are
familiar with the UNIX command line interface. There are many excellent books on the
subject, such as “Sams Teach Yourself UNIX in 24 Hours”.

Starting

To start Knoppix in text mode, enter this at the boot prompt.

knoppix 2

For example, to start with UK keyboard/language, with DMA for faster hard disk access,
and without PCMCIA because you're not working on a laptop computer, enter:

knoppix lang=uk dma nopcmcia 2

Leaving

Enter this command to exit Knoppix:

halt

Localisation

Text mode is called “runlevel 2”. When started in text mode, Knoppix uses the “C” locale.
The C locale is defined as the “default” locale for applications, meaning that their strings
are displayed as written in the initial code, without passing through a translation lookup.
Just plain old ASCII. Literally, the “C” locale turns off localisation.

To enable localisation, specify the locale that you want to use with the “lang=” option. For
example, enter this at the boot prompt to load Knoppix in text mode with the UK regional
settings:

knoppix 2 lang=uk

Adjusting the keyboard layout

To switch to a UK keyboard layout, type this and press Enter:

loadkeys uk

The keyboard map will be changed to UK layout.

Accessing disks and partitions

Use the “mount” command. For example, to mount the first partition on the primary
master IDE hard drive:

cd /mnt
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mount hda1

The files on the device /dev/hda1 will be mounted to /mnt/hda1. To view the files on the
partition:

cd hda1
ls

The files will be displayed. To learn more about navigating and copying files in text mode,
refer to a UNIX manual or text book.

Important
Disks and partitions are mounted read-write by the mount command.

Identifying hardware

Use these commands to get hardware information:

Command Shows

lspci PCI devices

lsusb USB devices

cat /proc/cpuinfo Processor information

cat /proc/meminfo Random Access Memory details

cat /proc/scsi/scsi SCSI device information

dmesg Kernel messages

Tip
Press Shift + Page Up to see the lines that have scrolled off the top of the screen.
Press Shift + Page Down to go back down again.

Knoppix boot options

knoppix lang=cn                     Specify language/keyboard (cn,de,da,es,fr,it,nl,pl,ru,sk,tr,tw or us)
knoppix alsa (or alsa=es1938)       Use ALSA sound driver (at your own risk)
knoppix desktop=fluxbox             Specify Window Manager (fluxbox,icewm,kde,larswm,twm,wmaker or xfce)
knoppix screen=1280x1024            Use specified Screen resolution for X
knoppix xvrefresh=60 (or vsync=60)  Use 60 Hz vertical refresh rate for X
knoppix xhrefresh=80 (or hsync=80)  Use 80 kHz horizontal refresh rate for X
knoppix xserver=XFree86             Use specified X-Server ( XFree86 or XF86_SVGA )
knoppix xmodule=ati                 Use specified XFree4-Module (ati,fbdev,i810,mga,nv,radeon,savage,s3 or svga)
knoppix 2                           Boot in runlevel 2 (Textmode)
knoppix floppyconfig                Run "knoppix.sh" from a floppy
knoppix myconf=/dev/sda1            Run "knoppix.sh" from a partition
knoppix myconf=scan (or config=scan) Try to find "knoppix.sh" automatically
knoppix home=/dev/sda1/knoppix.img  Mount loopback file as /home/knoppix
knoppix home=scan                   Automatic search for knoppix homedir
knoppix no{apic,agp,apm,audio,ddc}  Skip parts of HW-detection (1)
knoppix no{firewire,pcmcia,scsi}    Skip parts of HW-detection (2)
knoppix no{swap,usb}                Skip parts of HW-detection (3)
failsafe                            Boot with (almost) no HW-detection
knoppix pci=irqmask=0x0e98          Try this, if PS/2 mouse doesn't work *)
knoppix pci=bios                    Workaround for bad PCI controllers
knoppix ide2=0x180 nopcmcia         Boot from PCMCIA-CD-Rom (some notebooks)
knoppix mem=128M                    Specify Memory size in MByte
knoppix dma                         Enable DMA for ALL IDE-Drives
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knoppix noeject                     Do NOT eject CD after halt
knoppix noprompt                    Do NOT prompt to remove the CD
knoppix vga=normal                  No-framebuffer mode, but X
knoppix blind                       Start Braille-Terminal (no X)
knoppix brltty=type,port,table      Parameters for Braille device
knoppix wheelmouse                  Enable IMPS/2 protocol for wheelmice
knoppix nowheelmouse                Force plain PS/2 protocol for PS/2-mouse
fb1280x1024                         Use fixed framebuffer graphics (1)
fb1024x768                          Use fixed framebuffer graphics (2)
fb800x600                           Use fixed framebuffer graphics (3)
knoppix keyboard=us xkeyboard=us    Use different keyboard (text/X)
knoppix splash                      Boot with fancy background splashscreen
knoppix toram                       Copy CD to RAM and run from there
knoppix tohd=/dev/hda1              Copy CD to HD partition and run there
knoppix fromhd=/dev/hda1            Boot from previously copied CD-Image
knoppix testcd                      Check CD data integrity and md5sums
expert                              Interactive setup for experts
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